
Zanim przyst±  siê 

Instrukcja w formie elektronicznej wydana i korzystania zinstrukcji
ia, 7 czerwcza, 1998 r."

rzacz muzyki, radio 
pisz do instalacji oprogramowania, zapoznaj
z tre¶ci± tego podrêcznika!

 zosta³a zgodnie z zasadami zawartymi w dokumencie "Zasady i warunk
obs³ugi produktów firmy Nok

• Cyfrowy odtwa
9353563
Wydanie 1.

FM, funkcja wybierania g³osowego, 
mo¿liwo¶æ prze³±czania bez u¿ycia 
r±k oraz Music Call (po³±czenie 
z muzyk± w tle) – wszystko 
w jednym urz±dzeniu.

• Program Nokia Audio Manager 
z sieci Internet connection 

• Prosty w u¿yciu program Nokia CD 
Manager (podstawowe dzia³ania)

• W³asne zasilanie – mo¿e, ale nie 
musi byæ u¿ywany wraz z telefonem 
Nokia

• Kompatybilny z telefonami Nokia 
3310, 3330, 8210, 8250, 8850 i 
8890. ((Patrz rysunki.)
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A MOBILES PHONES Ltd. z pe³n± odpowiedzialno¶ci± o¶wiadczamy, ¿e produkt NOKIA MUSIC PLAYER spe
jête w klauzulach dokumentu Council Directive: 1999/5/EC. 

 © 2001. Nokia Mobile Phones. Wszelkie prawa zastrze¿one.

ie, przekazywanie, dystrybucja oraz przechowywanie elektronicznej kopii czê¶ci lub ca³o¶ci tego dokumen
lwiek formie bez uprzedniej pisemnej zgody firmy Nokia s± zabronione.

okia Connecting People s± zarejestrowanymi znakami towarowymi firmy Nokia Corporation. Inne nazwy 
ne w niniejszym dokumencie mog± byæ znakami towarowymi lub nazwami handlowymi ich w³a¶cicieli.

kia promuje politykê nieustannego rozwoju. Firma Nokia zastrzega sobie prawo do wprowadzania zmian 
 produktach opisanych w tym dokumencie bez uprzedniego powiadomienia.

h okoliczno¶ciach firma Nokia nie ponosi odpowiedzialno¶ci za jak±kolwiek utratê danych lub zysków cz
e, przypadkowe, wynikowe lub po¶rednie szkody spowodowane w dowolny sposób.

æ tego dokumentu przedstawiona jest „tak jak jest — as is”. Nie udziela siê jakichkolwiek gwarancji, zarów
zumianych, w³±czaj±c w to, lecz nie ograniczaj±c tego do, jakichkolwiek dorozumianych gwarancji u¿ytecz
atno¶ci do okre¶lonego celu, chyba ¿e takowe wymagane s± przez przepisy prawa. Firma Nokia zastrzega
nia zmian w tym dokumencie lub wycofania go w dowolnym czasie bez uprzedniego powiadomienia.

uzyczne s± chronione umowami miêdzynarodowymi i prawem autorskim danego kraju. Kopiowanie i odt
muzycznych mo¿e wi±zaæ siê z potrzeb± uzyskania zgody lub licencji. W niektórych krajach prawo zabra
by prywatne materia³u objêtego prawem autorskim. Zapoznaj siê z obowi±zuj±cymi we w³asnym kraju pr
orzystania z tego rodzaju materia³ów.

¶æ poszczególnych produktów mo¿e siê ró¿niæ w zale¿no¶ci od regionu. Szczegó³y mo¿na uzyskaæ u najbl
cy firmy Nokia.
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p – Dla w³asnego bezpieczeñstwa

oznaj siê z poni¿szymi wskazówkami. Nieprzestrzeganie zaleceñ mo¿e byæ niebezpiecz
godne z prawem. Szczegó³owe informacje znajdziesz na dalszych stronach tej instruk

zyj te¿ do instrukcji obs³ugi telefonu, aby zapoznaæ siê z jego dzia³aniem, sposobami e
serwacji, jak równie¿ z przepisami bezpieczeñstwa.

Bezpieczeñstwo na drodze jest najwa¿niejsze

Telefon komórkowy Nokia mo¿esz pod³±czyæ do odtwarzacza Nokia Music Player,
korzystaj z telefonu, gdy prowadzisz samochód; najpierw go zaparkuj.

Zak³ócenia radiowe

Wszystkie urz±dzenia bezprzewodowe mog± odbieraæ i powodowaæ zak³ócenia ra

Wy³±czaj urz±dzenie na terenie szpitala

Stosuj siê do obowi±zuj±cych przepisów i zasad. Je¶li odtwarzacz muzyki Nokia M
jest pod³±czony do telefonu, wówczas wy³±cz telefon, gdy znajdziesz siê w pobli¿
medycznej.

Nie w³±czaj urz±dzenia na pok³adzie samolotu 

Urz±dzenia bezprzewodowe mog± zak³ócaæ dzia³anie systemów pok³adowych. Wy
odtwarzacz muzyki zanim wejdziesz na pok³ad samolotu. U¿ywanie tych urz±dzeñ
jest prawnie zabronione.

Wy³±cz urz±dzenie, gdy tankujesz samochód

Nie u¿ywaj telefonu na stacjach benzynowych. Nie rób tego te¿ w pobli¿u sk³adó
chemikaliów.
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Wy³±cz urz±dzenie w rejonie przeprowadzania wybuchów

Nie u¿ywaj telefonów ani innych urz±dzeñ nadawczo-odbiorczych w czasie odpa
³adunków wybuchowych. Zwróæ baczn± uwagê na wszystkie ograniczenia i zasto
obowi±zuj±cych przepisów.

Korzystaj z pomocy fachowców

Instalacje i naprawy zlecaj wy³±cznie wykwalifikowanym specjalistom.

Baterie i akcesoria

U¿ywaj wy³±cznie zatwierdzonych do u¿ytku baterii i akcesoriów. Nie ³±cz ze sob
niekompatybilnych.

Pod³±czanie innych urz±dzeñ

Zanim pod³±czysz dodatkowe urz±dzenie, zapoznaj siê z instrukcj± jego obs³ugi i 
bezpieczeñstwa. Nie pod³±czaj urz±dzeñ nie przeznaczonych do wspó³pracy ze sob
rób kopie zapasowe wszystkich wa¿nych danych.

Poziom g³o¶no¶ci

Zale¿y nam, aby¶ czerpa³ przyjemno¶æ ze s³uchania muzyki, ale b±d¼ ostro¿ny i nie
zbyt g³o¶no. Zbyt g³o¶na muzyka mo¿e spowodowaæ uszkodzenie narz±dów s³uch
uwadze, gdy wybierasz poziom g³o¶no¶ci.

S³uchawki i naszyjnik

Nie u¿ywaj s³uchawek i naszyjnika, je¶li mo¿e to byæ niebezpieczne.
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p – Jak korzystaæ z odtwarzacza Nokia Music Player

sposoby korzystania z odtwarzacza muzyki Nokia Music Player. 

rzacz niezale¿ny
ia Music Player jest ma³ym, ale wysokiej jako¶ci i przeno¶nym odtwarzaczem muzyki. 
okia Music Player jako niezale¿nego urz±dzenia przeczytasz w punkcie Nokia Music P
iêci – odtwarzanie.

rzacz w po³±czeniu z telefonem Nokia
³±czonego z Nokia Music Player telefonu Nokia mo¿esz korzystaæ bez potrzeby u¿ycia
i±c, bêdziesz móg³ odbieraæ i nawi±zywaæ po³±czenia, nawet nie dotykaj±c telefonu. 

ystaniu z Nokia Music Player w po³±czeniu z telefonem przeczytasz w punkcie Nokia 
orzystanie z mikro-zestawu.

waga: Poniewa¿ tylko jeden port s³u¿y zarówno do kablowego po³±czenia z telefon
z PC, nie mo¿na pod³±czyæ obu tych urz±dzeñ jednocze¶nie.

rzacz pod³±czony do PC
ia Music Player pobiera z PC pliki muzyczne i zapisuje je bezpo¶rednio na swojej karci
cej o korzystaniu z Nokia Music Player w po³±czeniu z PC przeczytasz w punktach No
nager – Wykorzystanie i Nokia CD Manager.
waga: Nie korzystaj z tego produktu w sposób niew³a¶ciwy, a wiêc nie naruszaj pr

autorskich osób trzecich i innych przepisów dotycz±cych pobierania i odtw
plików muzycznych.

Niniejsza licencja wa¿na jest tylko na jeden komputer. Je¶li planujesz korzy
z oprogramowania na kilku komputerach, musisz je zarejestrowaæ na ka¿dy
komputer z osobna.
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p – Zawarto¶æ pakietu sprzeda¿nego

kia Music Player Bateria AAA, (1)

Naszyjnik

abel do telefonu

bel do s³uchawek
P³yta CD-ROM
Karta pamiêci

Karta gwarancyjna (nie

Kabel USB



a Mobile Phones.
awa zastrze¿one.

trona

d ty³u

hold

volume

rywka baterii

Klips

Z³±cze do
s³uchawek

ryjny
10

Wstê

Przyk

Z³±c
Phon

m

aud
Copyright © 2001 Noki
Wszelkie pr

p – Schemat odtwarzacza Nokia Music Player

Lewa strona Przód Prawa s

Widok od do³u

Widok o

rywka baterii

ze 
e/PC
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ode

io/off

Z³±cze 
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Mikrofon

Wy¶wietlacz

Przewijanie 
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Odtwarzanie/
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Prze³±cznik  
(Odbierz/ zakoñcz)

Z³±cze do
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Przewijanie
do przodu

Przyk

Numer se

Przykrywka karty 
pamiêci
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r oprogramowania

 móc korzystaæ z odtwarzacza, musisz dysponowaæ jednym z dwóch modu³ów oprogra

CD Manager
gram Nokia CD Manager pozwala kopiowaæ utwory z CD, zmieniaæ ich nazwy i przeno
sic Player. Po³±czenie z Internetem nie jest konieczne. 

wy w u¿yciu
arz±dzanie odczytem z CD
atwe przesy³anie utworów do Nokia Music Player
bs³ugiwany jest tylko format AAC 64 kb/s (64 kb/s to jedna godzina na karcie 32MB).

Audio Manager
ia Audio Manager to kompletny program, który pozwala kopiowaæ muzykê z CD (odcz
rania z Internetu, tworzyæ bazy danych z utworami muzycznymi i przesy³aæ je do Noki
er. Aby przez Nokia Audio Manager móc uzyskaæ dostêp do CD Database, trzeba siê n
czyæ z Internetem. 

stawowe funkcje
D Reader (AAC)
arz±dzanie baz± danych (formaty: MP3, AAC, itp.) z praktycznie dowolna liczb± plików
obieranie utworów do odtwarzacza Nokia Music Player
o³±czenie z Internetem (pobieranie muzyki)



a Mobile Phones.
awa zastrze¿one.
12

Pobie
Copyright © 2001 Noki
Wszelkie pr

ranie i s³uchanie muzyki

Pobierz muzykê

Po³±czenie z Internetem
Bez po³±czenia z Internetem
Pocz±tkuj±cy u¿ytkownicy

Nokia Audio Manager Nokia CD Manager
Zainstaluj

Odczytaj CD

Zrób listê utworów

Skopiuj do Nokia 
Music Player

Pos³uchaj muzyki

Instalacja Instalacja

Patrz punkt Jak utworzyæ 
w³asn± listê utworów

Patrz punkt Jak 
odczytywaæ p³yty CD

Patrz punkt Przesy³anie 
plików muzycznych do 

karty d¼wiêkowej

Patrz punkt 
Odczytywanie p³yty CD

Patrz punkt Zmiana 
nazw utworów

Patrz punkt Kopiowanie 
do odtwarzacza i 

ods³uchiwanie muzyki

Patrz punkt Odtwarzanie z karty pamiêci
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o i ³atwo

CD Manager

alacja Nokia CD Manager

¿ p³ytê CD-ROM do komputera. Zainstaluj oprogramowanie, wybieraj±c odpowiedni± i
nym. Po³±czenie z Internetem nie jest potrzebne.

waga: Nie pod³±czaj Nokia Music Player do komputera, zanim nie zainstalujesz pr
Nokia CD Manager.

Zanim pod³±czysz odtwarzacz do telefonu lub komputera, przeczytaj punkt 
kroki, aby dowiedzieæ siê jak:

• zainstalowaæ bateriê,
• pod³±czyæ kabel s³uchawek,
• w³o¿yæ kartê pamiêci.

³±czanie odtwarzacza Nokia Music Player

³±cz kabel USB do z³±cza Phone/PC i do portu USB komputera.

czanie odtwarzacza Nokia Music Player

³±cznik audio/off ustaw w pozycji audio. 

chamianie programu Nokia CD Manager

bierz program Nokia CD Manager z menu startowego.

³adanie p³yty CD

¿ p³ytê CD z muzyk± do komputera.

bór utworów muzycznych

nij tytu³y, aby zaznaczyæ te utwory, które chcesz przes³aæ do komputera.
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Przesy³anie utworów z CD

Kliknij Read a CD, aby przes³aæ wybrane utwory do PC.

Zmiana nazw utworów

Prawym przyciskiem myszy kliknij ¿±dany utwór. Wprowad¼ tytu³y utworów lub zmieñ ich
tytu³y.

Zapisywanie utworów po zmianie ich nazw

Kliknij Rename, aby zamkn±æ okno i zapisaæ zmieniony tytu³.

Kopiowanie do odtwarzacza Nokia Music Player

Z lewej strony ekranu zaznacz utwory, które chcesz przes³aæ do Nokia Music Player. Klikni
Wybrane utwory zostan± przes³ane do odtwarzacza Nokia Music Player.

ia Audio Manager

Instalacja programu Nokia Audio Manager

W³ó¿ p³ytê CD-ROM do komputera. Zainstaluj oprogramowanie, wybieraj±c odpowiedni± i
g³ównym. 

Uwaga: Zanim po³±czysz odtwarzacz z telefonem lub komputerem, przeczytaj tre¶æ
Pierwsze kroki, aby dowiedzieæ siê jak:

• zainstalowaæ bateriê,
• pod³±czyæ kabel s³uchawek,
• w³o¿yæ kartê pamiêci.

Pod³±czanie odtwarzacza Nokia Music Player

Pod³±cz kabel USB do z³±cza Phone/PC i do portu USB komputera.
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W³±czanie odtwarzacza Nokia Music Player
Prze³±cznik audio/off ustaw w pozycji audio. 

Uruchamianie programu Nokia Audio Manager
Wybierz program Nokia Audio Manager z menu startowego.

Wk³adanie p³yty CD
W³ó¿ p³ytê CD z muzyk± do komputera.

Pobieranie utworów z p³yty CD
Kliknij make a playlist, a nastêpnie read a CD.

Pobieranie tytu³ów z CD Database
Je¶li szukanych utworów nie ma na p³ycie CD, program Nokia Audio Manager zapyta, czy 
pobraæ z bazy internetowej CD Database. Kliknij Yes. Musisz po³±czyæ siê z Internetem.

Wybieranie utworów
Kliknij pola obok utworów, które chcesz skopiowaæ do muzycznej bazy danych.

Rozpoczêcie odczytywania utworów
Kliknij Start Reading. Po skopiowaniu wybranych utworów pojawi siê komunikat Recordin
successfully. Oznacza on, ¿e utwory te zosta³y dodane do muzycznej bazy danych.

Wybieranie utworów z bazy danych
Kliknij Select Tracks From Database. 

Wybieranie utworów z listy
Kliknij pola obok utworów, które chcesz skopiowaæ i dodaæ do listy, po czym kliknij OK.



Szy

16 a Mobile Phones.
awa zastrze¿one.

Music Player

j pole obok 
i na koniec 

awi siê 
ania pojawi 

Nok
bko i ³atwo

Copyright © 2001 Noki
Wszelkie pr

Zapisywanie wybranych utworów na li¶cie

Kliknij Save Tracks as Playlist i wprowad¼ nazwê listy utworów. Kliknij Close.

Kopiowanie do odtwarzacza Nokia Music Player

Kliknij copy to devices.

Wybieranie utworów lub list utworów w celu ich skopiowania do odtwarzacza Nokia 

Kliknij Select Tracks From Database lub Select Playlists From Database, po czym klikni
utworów lub listy utworów, które chcesz skopiowaæ do odtwarzacza Nokia Music Player, 
kliknij OK.

Kopiowanie do odtwarzacza Nokia Music Player

Sprawd¼, czy odtwarzacz Nokia Music Player jest w³±czony. Kliknij Copy To Portable. Poj
komunikat Sending to device i okno z miar± postêpu kopiowania. Po zakoñczeniu kopiow
siê komunikat Finished transferring tracks. Kliknij OK.

ia Music Player

W³±czanie odtwarzacza muzyki (tryb gotowo¶ci)

Prze³±cznik audio/off ustaw w pozycji audio. 

Rozpoczêcie odtwarzania

Naci¶nij .

Regulacja g³o¶no¶ci

Poziom g³o¶no¶ci ustawisz, naciskaj±c przycisk regulacji w górê + lub w dó³ –.
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Przerwa w odtwarzaniu

W trakcie odtwarzania naci¶nij .

Powrót do odtwarzania

W trakcie przerwy w odtwarzaniu naci¶nij .

Wybór utworów muzycznych

Aby przej¶æ do nastêpnego utworu, naci¶nij . Aby przej¶æ do poprzedniego utworu, dw
naci¶nij .

Przegl±danie utworów

Naci¶nij i przytrzymaj  lub . Odtwarzanie rozpocznie siê na nowo po zwolnieniu pr
lub .

io FM

W³±czanie odtwarzacza muzyki

Prze³±cznik audio/off ustaw w pozycji audio. 

Prze³±czanie odtwarzacza na radio FM

Naci¶nij przycisk mode i przytrzymaj go do momentu pojawienia siê komunikatu 

Wybór czêstotliwo¶ci

Naciskaj  lub  do momentu znalezienia ¿±danej czêstotliwo¶ci.

Regulacja g³o¶no¶ci

Poziom g³o¶no¶ci ustawisz, naciskaj±c przycisk regulacji w górê + lub w dó³ –.

FM
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ro-zestaw
Aby korzystaæ z mikro-zestawu, nale¿y pod³±czyæ odtwarzacz Nokia Music Player do telef
(Patrz punkt Odtwarzacz Nokia Music Player w po³±czeniu z telefonem).

Odbieranie po³±czeñ

Naci¶nij i przytrzymaj przez sekundê przycisk .

Nawi±zywanie po³±czeñ (tylko telefony Nokia 3310 i 8890)

1. Naci¶nij i przytrzymaj , a¿ us³yszysz sygna³ linii telefonicznej.

2. Wypowiedz nazwê przypisan± do jednego z numerów zapisanych w telefonie Nokia.

Zakoñczenie po³±czenia

Naci¶nij przycisk .
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acja programu Nokia Audio Manager

cja
nstalowaæ program Nokia Audio Manager, komputer musi spe³niaæ ni¿ej wymienio
lne wymagania systemowe: 

waga: Je¶li nie masz po³±czenia z Internetem, przeczytaj punkt Instalacja program
CD Manager.
Nie pod³±czaj odtwarzacza Nokia Music Player do komputera, zanim nie 
zainstalujesz programu Nokia CD Manager lub Nokia Audio Manager.

ji rozpocznie siê w wyniku klikniêcia przycisku Install the Nokia Audio Manager w
 Program (Install program) for the Nokia Music Player' na CD-ROM.

³adanie p³yty CD-ROM do komputera

knij wszystkie inne aplikacje, po czym w³ó¿ do komputera p³ytê CD-ROM otrzyman± w
twarzaczem Nokia Music Player. Wiêcej szczegó³ów znajdziesz w instrukcji obs³ugi ko
alacja programu Nokia Audio Manager na dysku twardym rozpocznie siê automatyczn
raniu przycisku instalacyjnego w Main Product Menu. Aby pomy¶lnie ukoñczyæ instala
dnie z pojawiaj±cymi siê na ekranie instrukcjami.

ent Wymagania
puter Zgodny z IBM PC/AT.
esor Pentium MMX 266 MHz (wymagany). Pentium 300 MHz (zalecany)
iêæ Minimum 48 MB (zalecane). Dla Windows 2000 zaleca siê 64 MB.
 twardy Do instalacji oprogramowania potrzeba 35 MB wolnego miejsca. Do

potrzebne jest dla plików muzycznych.
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acja programu Nokia Audio Manager – B³±d instalacji

cie programu Nokia Audio Manager

omatyczne usuniêcie programu Nokia Audio Manager (z menu Start)

bierz kolejno Start > Programy > Nokia > Nokia Audio Manager > Uninstall Nokia
nager.

têpuj zgodnie z pojawiaj±cymi siê na ekranie instrukcjami, co zapewni bezpieczne usu
gram Nokia Audio Manager.
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acja programu Nokia CD Manager

cja
jê rozpoczniesz klikniêciem przycisku Install the Nokia Audio Manager w oknie 'S
 (Install program) for the Nokia Music Player' na dysku CD-ROM.

³adanie p³yty CD-ROM do komputera

knij wszystkie inne aplikacje, a nastêpnie w³ó¿ do komputera p³ytê CD-ROM otrzyman
twarzaczem Nokia Music Player. W oknie 'Install Nokia Audio Manager' wybierz przyc
alacyjny, w wyniku czego rozpocznie siê instalacja programu Nokia CD Manager na dy
putera. Aby pomy¶lnie ukoñczyæ instalacjê, postêpuj zgodnie z pojawiaj±cymi siê na e
rukcjami.

waga: Nie pod³±czaj odtwarzacza Nokia Music Player do komputera, zanim nie 
zainstalujesz programu Nokia CD Manager.
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Katalog docelowy dla plików programu to C:\Program Files\Nokia\CD Manager. Aby kon
kliknij Next>. Zaleca siê korzystanie z tego katalogu z uwagi na zawarte w nim ³±cza do i
programów.
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Instalacja zakoñczona. Kliknij Close.



a Mobile Phones.
awa zastrze¿one.

 Manager.

niêcie 
stalacji tego 
all program) 
24

Instal

Usuniê

Aut

Je¶l
 Wy

Pos
pro
pro
for 
Copyright © 2001 Noki
Wszelkie pr

acja programu Nokia CD Manager – B³±d instalacji

cie programu Nokia CD Manager

omatyczne usuniêcie programu Nokia CD Manager (z menu Start)

i wyst±pi b³±d instalacji, kliknij Cancel. 
bierz kolejno Start > Programy > Nokia > Nokia CD Manager > Remove Nokia CD

têpuj zgodnie z pojawiaj±cymi siê na ekranie instrukcjami, co zapewni bezpiecznie usu
gramu Nokia CD Manager. Po usuniêciu programu Nokia CD Manager, ponów próbê in
gramu, klikaj±c przycisk Install the Nokia CD Manager w oknie 'Set-up Program (Inst
the Nokia Music Player' na dysku CD-ROM.
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 Music Player – Pierwsze kroki

owanie Nokia Music Player do odtwarzania sprowadza siê do kilku prostych czynn
ykonaj starannie. 

owanie baterii

arcie przykrywki baterii

trzymaj odtwarzacz Nokia Music Player ty³em zwróconym do siebie. Naci¶nij przykryw
ci±gnij ja do siebie (2), w kierunku strza³ek widocznych na przykrywce. Ostro¿nie odch
y³u, otwieraj±c w ten sposób komorê baterii (3).

1

2
3
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Wk³adanie baterii

Do komory w³ó¿ bateriê jej koñcem ze znakiem +. 

 Zamknij przykrywkê baterii

Przykrywê baterii przechyl w 
czym delikatnie naci¶nij i prze
swoje miejsce (2), zamykaj±c 
komorê baterii.

1

2

1

2
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Pod³±czanie kabla s³uchawek
W³ó¿ koñcówkê kabla s³uchawek do gniazda z prawej strony odt

Uwaga: Pod³±czanie i od³±czanie kabla s³uchawek wymag
ostro¿no¶ci. Uchwyæ kabel za jego grubszy odcinek
metalow± wtyczk±. Nigdy nie wk³adaj ani nie wyj
wtyczki, popychaj±c lub ci±gn±æ za sam kabel.

³adanie karty pamiêci

Otwieranie pokrywy karty p

Pokrywê karty pamiêci otworz
poci±gaj±c j± tak, jak to pokaz
rysunku obok.
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Wk³adanie karty pamiêci

Nie zamykaj±c pokrywy, odwróæ odtwarzacz Nokia Music Player spodem do góry. Trzymaj
pamiêci z naklejk± do góry, w³ó¿ i wepchnij kartê do jej gniazda. Karta pamiêci zatrza¶nie
miejscu. 

Uwaga: Przed instalacj± karty pamiêci sprawd¼, czy odtwarzacz Nokia Music Player
wy³±czony.
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Zamykanie pokrywy karty pamiêci

Wsuñ wypustkê pokrywy karty pamiêci do komory karty pamiêci.

Uwaga: Je¿eli karta pamiêci jest w³o¿ona nieprawid³owo, nie bêdzie mo¿na zamkn±
pokrywy. Wyjmij kartê pamiêci (patrz ni¿ej) i w³ó¿ j± z powrotem.

mowanie karty pamiêci

Otwieranie pokrywy karty pamiêci

Pokrywê karty pamiêci otworzysz, poci±gaj±c j± tak, jak to pokazano na rysunku obok.
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Wyjmowanie karty pamiêci

Doci¶nij kartê pamiêci (1). Doci¶niêta karta pamiêci jak sprê¿yna sama wyskoczy z komory
kartê pamiêci i wyjmij j± z odtwarzacza Nokia Music Player.

Uwaga: Nie wyjmuj karty pamiêci, gdy odtwarzacz Nokia Music Player jest w³±czon
Mog³oby to spowodowaæ utratê nagranych na karcie pamiêci utworów i usz
samej karty.

1 2
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nosiæ odtwarzacz Nokia Music Player

Zak³adanie s³uchawek

Lewa s³uchawka jest oznaczona liter± L. W³ó¿ s³uchawkê do lewego ucha. D³u¿szy kabel s
kana³em prawym. Z ty³u, za szyj± umie¶æ kabel prawego kana³u, a s³uchawkê w³ó¿ do praw
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Sposoby noszenia odtwarzacza Nokia Music Player

Z ty³u odtwarzacza znajduje siê klips, który mo¿na zaczepiæ lub zawiesiæ na ubraniu letnim
zimowym. Odtwarzacz mo¿na zawiesiæ niemal wszêdzie, np. na górnej kieszonce lub ko³ni
czy marynarki. 
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Zwi±zanie kabla s³uchawek z naszyjnikiem

Zanim pod³±czysz kabel s³uchawek do odtwarzacza Nokia Music Pla
przeci±gnij go przez oznaczony etykiet± Nokia uchwyt kabla. 

Przymocowanie paska do odtwarzacza Nokia Music Player

Obwi±¿ pasek wokó³ haczyka, który znajdziesz z ty³u odtwarzacza N
Player.
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Zak³adanie naszyjnika

Prze³ó¿ naszyjnik przez g³owê i zawie¶ na nim odtwarzacz Nokia Music Player.

Uwaga: Kabel s³uchawki s³u¿y te¿ jako antena radia FM. Korzystanie z naszyjnika za
popl±taniu siê kabla mikro-zestawu i poprawia odbiór radia FM. 
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czanie odtwarzacza do komputera

waga: Zanim pod³±czysz Nokia Music Player do komputera, musisz zainstalowaæ p
Nokia Audio Manager lub Nokia CD Manager. 

Jak ods³oniæ z³±cze Phone/PC

Otwórz pokrywê z³±cza Phone/PC. Otwarta pokrywa z³±cza Phone/PC
przymocowana do odtwarzacza Nokia Music Player.

Uwaga: Aby zapobiec dostaniu siê kurzu, brudu lub wilgoci do 
Phone/PC, zawsze zamykaj jego pokrywê, je¶li ze z³±cz
korzystasz.

 Pod³±czanie Nokia Music Player

Pod³±cz kabel USB do z³±cza Phone/PC, starannie dopasowuj±c wtyc
gniazdka. 

waga: Zachowuj ostro¿no¶æ przy pod³±czaniu i od³±czaniu kabla s³uchawek. Chwy
za jego grubszy odcinek, tu¿ nad metalow± wtyczk±. Nigdy nie wk³adaj ani
wyjmuj kabla trzymaj±c go lub ci±gn±c za sam tylko przewód.

C
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Pod³±czanie odtwarzacza do komputera

Pod³±cz kabel USB do z³±cza USB w komputerze. Wiêcej szczegó³ów znajdziesz w instrukc
komputera. 

Uwaga: Nokia Music Player, gdy pod³±czany do komputera, powinien byæ w trybie g
Prze³±cznik Audio/off ustaw w pozycji off, po czym przestaw go na pozycjê
Odtwarzacz przejdzie do trybu gotowo¶ci.

Uwaga: Je¶li nie zamierzasz korzystaæ z odtwarzacza przez d³u¿szy czas, od³±cz go 
komputera i wy³±cz.

W³±czanie odtwarzacza

Prze³±cznik Audio/off ustaw w pozycji Audio. 

Uwaga: Je¶li w odtwarzaczu nie ma karty lub gdy j± w³o¿ono niepraw
pojawi siê komunikat . Je¶li karta pamiêci jest p
pojawi siê komunikat .

Nieu¿ywany przez 3 minuty odtwarzacz przejdzie w tryb u¶p
wy¶wietlacz pozostanie pusty. Naci¶nij , aby wyj¶æ z try
u¶pienia.

NoMedia

NoTracks
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 Audio Manager – Wykorzystanie

zanie muzyk±
ony do komputera odtwarzacz wraz z programem Nokia Audio Manager pozwala

iowaæ utwory muzyczne z p³ytoteki CD

acza to, ¿e mo¿esz kopiowaæ muzykê z p³yt CD i przenosiæ j± na karty pamiêci odtwar
sic Player.

ieranie utworów z Internetu

¿esz pobieraæ kodowane pliki muzyczne z sieci Internet i ³adowaæ je do komputera lub
iêci, aby móc je pó¼niej odtwarzaæ.

 zorganizowaæ p³ytotekê

¿esz zrobiæ listê swoich ulubionych utworów muzycznych. Listê tak± mo¿esz za³adowa
worami do odtwarzacza Nokia Music Player. Mo¿esz równie¿ zorganizowaæ p³ytotekê,

oby wg rodzaju muzyki.

waga: Po³±czenie z Internetem jest potrzebne tylko wtedy, gdy chcesz pobieraæ ut
z internetowej bazy Compact Disc DataBase.

Pliki MP3 utworzone dla Nokia Music Player s± kodowane i nie mo¿na ich o
w innych urz±dzeniach.

Produkt ten jest tak skonstruowany, ¿e sam przestrzega praw autorskich i n
pozwala ich ³amaæ. (Patrz punkt Nokia Audio Manager – Rodzaje plików
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 uruchomiæ Nokia Audio Manager

Uruchamianie programu Nokia Audio Manager

Z menu 'Start' wybierz ikonê programu Nokia Audio Manager . Program zacznie siê ³ad
wy¶wietli ekran pocz±tkowy.
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Program Nokia Audio Manager spróbuje po³±czyæ siê z odtwarzaczem Nokia Music Player
komputera pojawi siê komunikat Looking for hardware player. 

Je¶li odtwarzacz muzyki jest w³±czony i prawid³owo pod³±czony, na wy¶wietlaczu Nokia M
przewija³ siê bêdzie komunikat .

Uwaga: Nawet gdy odtwarzacz Nokia Music Player jest pod³±czony do komputera, a
wy¶wietlaczu pojawi siê komunikat , nie bêdziesz móg³ korzyst
z odtwarzacza.

Gdy odtwarzacz jest wy³±czony lub gdy kabel Phone/PC nie jest pod³±czony
prawid³owo, na ekranie komputera pojawi siê komunikat Unable to commu
with portable device. Postêpuj zgodnie z wy¶wietlanymi na ekranie instruk
nie zapomnij przeczytaæ punktu Nokia Audio Manager – Komunikaty o b
w tym podrêczniku.

PCconnected

PCconnected
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ty klawiaturowe
tóre polecenia mo¿na wydawañ poprzez naci¶niêcie klawisza lub kombinacji klawisz
zeby poruszania kursorem. W niniejszej instrukcji skróty klawiaturowe wyró¿nione s±
nk± z podkre¶leniem tej litery, która stanowi dany skrót.

Wybór menu

Naci¶nij klawisz ALT i klawisz skrótu. Je¶li np. chcesz otworzyæ menu File, jednocze¶nie z 
ALT naci¶nij klawisz F. Menu File zostanie wówczas otwarte.

Wybieranie pozycji z otwartego menu

Naci¶nij skrót klawiaturowy. Je¿eli szukan± pozycj± otwartego menu Help bêdzie Help To
wystarczy ¿e naci¶niesz klawisz H. W rezultacie pojawi siê panel Help Topics.

Wybór przycisku

Naci¶nij skrót klawiaturowy. Je¶li tym przyciskiem ma byæ Select Tracks From Database,
naci¶nij T. W rezultacie pojawi siê panel Select Tracks From Database.
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oc – gdzie jej szukaæ?
ystaj±c z programu Nokia Audio Manager, stosuj siê ¶ci¶le do instrukcji. Je¶li czego¶ 
¶nij przycisk Help “?” w prawym górnym rogu jakiegokolwiek okna dialogowego, aby
êp do plików pomocy online i wybraæ odpowiedni temat. Je¶li np. nie wiesz, jak zako
nie, wybierz Help Topics z menu Help (górny lewy róg okna) i poszukaj interesuj±cego
 pomocy online zawieraj± szczegó³owe instrukcje dla wszystkich zadañ, które mo¿na
ogramie Nokia Audio Manager, jak i dla dodatkowych, nie ujêtych w tym podrêcznik

Uwaga: Po instalacji warto zapoznaæ siê z plikiem pomocy online.

Help “?
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1. Odtwarzanie muzyki z CD

rzanie CD

chamianie programu Nokia Audio Manager

 w³o¿yæ p³ytê CD

têpuj zgodnie ze wskazówkami, które znajdziesz w instrukcji obs³ugi komputera.

waga: Je¶li na p³ycie CD nie ma tytu³ów utworów muzycznych, na ekranie pojawi 
ostrzegawczy komunikat.

Naci¶nij Yes. Lista utworów zostanie sprowadzona z sieci Internet (CD Dat
wy¶wietlona na ekranie.

Aby mo¿na by³o pobraæ informacje o li¶cie utworów z bazy CD Database, ko
jest po³±czenie z sieci± Internet,.
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Pobieranie utworów z CD

Kliknij make a playlist, a nastêpnie kliknij Get Tracks From CD. 

Je¶li na li¶cie znajduj± siê ju¿ utwory muzyczne, wówczas w wyniku klikniêcia Get Tracks
otworzy siê okno dialogowe z zapytaniem, czy chcesz odtwarzaæ p³ytê (Play this CD), do³±c
listy (Append to Playlist) lub zrezygnowaæ (Cancel). Je¶li klikniesz Play this CD bie¿±ca l
zostanie zast±piona list± z utworami z p³yty CD. Je¶li wybierzesz Append to Playlist, utwo
zostan± dodane do bie¿±cej listy utworów.
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Wybór utworu muzycznego

Zaznacz kursorem i kliknij nazwê tego utwór, którego zamierzasz pos³uchaæ. Tytu³ utworu
pod¶wietlony, a z jego lewej strony pojawi siê zielony kwadracik. Informacje o wybranym 
pojawi± siê w prawym oknie.



Kro

45 a Mobile Phones.
awa zastrze¿one.

siê na zielon± 
ie jak jego 

 

ie siê 

awisz myszy i 
nego 

 z p³yty CD 
órne 
k 1. Odtwarzanie muzyki z CD

Copyright © 2001 Noki
Wszelkie pr

Odtwarzanie

Naci¶nij . Rozpocznie siê odtwarzanie wybranego utworu, a zielony kwadracik zmieni 
strza³kê. Na dole okna wy¶wietlane bêd± informacje (je¶li dostêpne) na temat utworu, tak
nazwa, czas trwania i nazwisko wykonawcy. 

Uwaga: Do odtwarzania muzyki potrzebna jest karta d¼wiêkowa. (Patrz punkt Dane
techniczne).

Wybór innego utworu

W trakcie odtwarzania utworu wybierz inn± ¶cie¿kê d¼wiêkow± i naci¶nij . Rozpoczn
odtwarzanie nowo wybranego utworu.

Skanowanie utworu

Podczas odtwarzania umie¶æ kursor nad przyciskiem SCAN, przytrzymaj wci¶niêty lewy kl
przesuñ przycisk SCAN do tego punktu ¶cie¿ki d¼wiêkowej, który wyznacza pocz±tek ¿±da
fragmentu utworu. Skanowanie utworu nie przerywa jego odtwarzania.

Ponawianie odtwarzania p³yty CD

Kliknij REPT. Wska¼nik REPT przyjmie kolor zielony, a po odtworzeniu wszystkich utworów
rozpocznie siê na nowo odtwarzanie od pierwszego utworu na p³ycie. Aby anulowaæ powt
odtwarzanie, naci¶nij ponownie REPT.

SCAN REPT SHUF
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Odtwarzanie losowe

Kliknij SHUF. Wska¼nik SHUF przyjmie kolor zielony, a utwory z p³yty CD bêd± odtwarzane
losowej. Aby anulowaæ odtwarzanie losowe, naci¶nij ponownie SHUF.

zystanie z trybu Small Player

Zmiana trybu na 'Small Player'

W prawej dolnej czê¶ci panelu kliknij przycisk , aby prze³±czyæ program Nokia Audio 
tryb 'Small Player'. 

W trybie Small Player mo¿na odtwarzaæ utwory z bie¿±cej listy utworów. Aby wróciæ do t
Player, kliknij Small Player prawym przyciskiem myszy i wybierz Big Player. 

SCAN Play SHUF REPT
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2. Jak odczytywaæ p³yty CD

anie utworów z p³yty CD
udio Manager umo¿liwia nagrywanie utworów z p³yt CD. Utwory nagrywane s± w
audio, a zapisywane na dysku twardym. 

 w³o¿yæ p³ytê CD

têpuj zgodnie ze wskazówkami, które znajdziesz w instrukcji obs³ugi komputera.

waga: Je¶li w³o¿ysz p³ytê CD w czasie dzia³ania programu Nokia Audio Manager, u
z p³yty zostan± automatycznie dodane do listy utworów muzycznych.

Je¶li na p³ycie CD nie ma tytu³ów utworów, na ekranie pojawi siê komunika
ostrzegawczy.

Naci¶nij Yes. Lista utworów zostanie pobrana z internetowej bazy (CD Data
wy¶wietlona na ekranie monitora.

Aby móc pobieraæ listy utworów z CD Database, konieczne jest po³±czenie 
z Internetem.

ieranie utworów z p³yty CD

nij read a CD.
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Wybór utworu muzycznego

Kliknij pole wyboru przy utworze, który chcesz zaznaczyæ. Pole wyboru zostanie zaznaczo

Usuwanie zaznaczenia

Kliknij pole wyboru obok utworu, którego zaznaczenie chcesz usun±æ.

Select all tracks 
[Wybór wszystkich u

Kliknij Tag All. 

Usuwanie zaznaczeñ
utworów

Kliknij Untag All. 

ect/Deselect 
znaczenia i ich usuwanie]

ag All [Zaznaczanie 
wszystkich pozycji]

Untag All [Usuwanie 
wszystkich zaznaczeñ]
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Rozpoczêcie odczytywania utworów

Kliknij Start Reading. Program Nokia Audio Manager zacznie kodowaæ i kopiowaæ wybran
dysk twardy. W dolnej prawej czê¶ci panelu pojawi siê pasek wskazuj±cy stopieñ zaawans
procesu. Po zakodowaniu i skopiowaniu utworu na dysk twardy zniknie zaznaczenie, a zam

 pojawi siê ikona . Kiedy ju¿ wszystkie utwory zostan± skopiowane na dysk twardy
komunikat Recording completed successfully! Kliknij OK. Nokia Audio Manager utworzy
danych listê utworów nagranych na p³ycie CD i do³±czy je do utworzonej listy.

Edycja informacji o utworach

W oknie read a cd kliknij Edit Track Info. Pojawi siê panel 'Review Playlist' z tytu³ami utw
Klikniêciem zaznacz utwór, który chcesz edytowaæ. Kliknij Review/Edit. Bêdziesz móg³ czy
informacje i wprowadzaæ nowe. Aby przej¶æ do poprzedniego lub nastêpnego utworu, nac
lub Next>>. Aby zapisaæ zmiany i zamkn±æ okno, naci¶nij Close. Je¶li chcesz anulowaæ zm
zamkn±æ okno, naci¶nij Cancel.

Rozpoczêcie 
odczytywania
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3. Korzystanie z bazy danych

anie utworów z Internetu
alekiej przysz³o¶ci bêdzie mo¿na pobieraæ pliki audio z Internetu. Nokia Audio Ma
 wykrywaæ takie pliki i automatycznie wprowadzaæ je do bazy danych.

 ³±czyæ siê z Internetem

nij club.nokia.com. Nokia Audio Manager wykorzysta po³±czenie z Internetem, aby we
b Nokia. 

waga: Je¶li odwiedzasz witrynê Club Nokia pierwszy raz, zapisz siê do tego klubu.
'Wst±p do Club Nokia'. Aby siê zarejestrowaæ, postêpuj zgodnie z instrukcja

Uwaga: Je¶li nie masz po³±cze
z Internetem, nie klika
club.nokia.com. Komp
mo¿e siê zawiesiæ i bê
musia³ go restartowaæ

egl±danie plików do pobierania

iedalekiej przysz³o¶ci Nokia Club bêdzie móg³ udostêpniaæ pliki do gratisowego lub p³a
ierania. Dodatkowe pliki bêdzie mo¿na pobieraæ z witryn partnerów firmy Nokia. Je¶li 
resuj±cej ciê witryny Web, wpisz ten adres i naci¶nij klawisz 'Enter'. Przyciski kontrolne
ck, Forward, Stop i Home) dzia³aj± tak samo jak w przegl±darce stron Web.

http://www.club.nokia.com/
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Pobranie plików

Aby pobraæ plik z Internetu, zazwyczaj nale¿y klikn±æ ³±cze prowadz±ce do ¿±danego pliku
na twardym dysku chcesz zapisaæ plik, który zostanie pobrany przez przegl±darkê. Pobran
automatycznie wprowadzane do bazy danych. Wiêcej o pobieraniu plików z Internetu prz
w dokumentacji przegl±darki stron WWW.

utworzyæ w³asn± listê utworów
ród utworów w bazie danych mo¿esz wybraæ te, z które chcesz umie¶ciæ na w³asnej l
 utworów przeznaczonych do odtwarzania na spotkaniach towarzyskich lub tych, któ
s³aæ do Nokia Music Player. Dodaj wybrane utwory do bie¿±cej listy, uszereguj je w ¿
jno¶ci i zapisz tak utworzon± listê.

Wybieranie utworów z bazy danych

Najpierw kliknij make a playlist, a nastêpnie Select Tracks From Database. Pojawi siê ok
Tracks From Database z list± wszystkich utworów zapisanych w bazie danych. Pokazane 
utworów, nazwiska wykonawców, czas odtwarzania, rodzaj muzyki i szybko¶æ bitowa. Klika
jakiej¶ kolumny, mo¿esz zmieniæ kolejno¶æ utworów na li¶cie. Gdy np. klikniesz Artist., utw
uporz±dkowane alfabetycznie wg nazwisk wykonawców.
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Wybór utworów dodawanych do listy

Kliknij pole wyboru przy utworze, który chcesz zaznaczyæ. Pole wyboru przy wybranym utw
zaznaczone. Mo¿esz te¿ klikn±æ Tag All, aby zaznaczyæ wszystkie pokazane utwory, lub U
usun±æ wszystkie zaznaczenia. Gdy ju¿ zaznaczysz utwory, które chcesz dodaæ do listy, kli

Jak zapisaæ w³asn± listê utworów

Kliknij Save Tracks as Playlist. 

Otworzy siê okno Add Playlist. Podaj nazwê w³asnej listy utworów i dodatkowe informacj
lub klikaj±c rozwijalne okna menu. Gdy ju¿ wprowadzisz informacje, kliknij Close, aby zap
listê utworów, lub kliknij Cancel, aby anulowaæ zmiany i zamkn±æ okno. Je¶li klikniesz Clo
komunikat The playlist has been saved. Kliknij OK.

Save Tracks as Playlist

Close Cancel OK
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4. Przesy³anie plików muzycznych do karty d¼wiêkowej

 Nokia Audio Manager pozwala przesy³aæ utwory muzyczne i ich listy do odtwar
layer. 

ieranie okna urz±dzeñ

nij copy to devices.

awanie utworów

 wybraæ i dodaæ utwory lub ich listê, kliknij odpowiednio przycisk Select T racks From
cisk Select Playlists From Database.

kopiowanie do urz±dzeñ

Select Tracks From Database Select Playlists From Database
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Wybór utworów do przes³ania

Kliknij pole wyboru przy utworze lub li¶cie utworów, które chcesz zaznaczyæ. Aby zaznacz
utwory, kliknij przycisk Tag All. Aby usun±æ zaznaczenie wszystkich wybranych dot±d utw
przycisk Untag All. Po wybraniu utworów lub listy utworów, które chcesz dodaæ do listy p
kliknij przycisk OK.

Uwaga: Je¿eli liczba utworów lub list utworów przekroczy pojemno¶æ karty pamiêc
siê komunikat Not enough room. Aby usun±æ zaznaczenie utworów lub lis
(np. w celu unikniêcia przekroczenia pojemno¶ci karty pamiêci), postêpuj zg
z instrukcjami pojawiaj±cymi siê na panelu.

Tag All Untag All

OK
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Kopiowanie wybranych utworów do karty pamiêci

Kliknij Copy to Portable. Pojawi siê tekst Converting file for download, a nastêpnie Send
i miara postêpu procesu. Po zakoñczeniu przesy³ania pojawi siê komunikat Finished trans
tracks. Kliknij OK. 

Usuwanie utworów z karty pamiêci

Wybierz utwory, które chcesz usun±æ z karty pamiêci, i kliknij , albo prawym klawiszem
dany utwór, po czym kliknij Remove. Utwór muzyczny zostanie usuniêty z karty pamiêci. 

Copy to Portable



a Mobile Phones.
awa zastrze¿one.

 WWW 
56

Krok 

Fun
club
Copyright © 2001 Noki
Wszelkie pr

5. Kopie zapasowe i przywracanie utworów muzycznych

kcja ta bêdzie dostêpna w niedalekiej przysz³o¶ci. Wiêcej o tym przeczytasz na stronie
.nokia.com.

http://www.club.nokia.com/
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 CD Manager

 Nokia CD Manager pozwala kopiowaæ muzykê z CD, zmieniaæ nazwy utworów i 
 do odtwarzacza Nokia Music Player. Do korzystania z programu Nokia CD Manag
±czenie z Internetem.

 ogólne o pobieraniu i s³uchaniu muzyki
gram Nokia CD Manager pozwala szybko pobraæ utwory muzyczne i je przes³uchaæ.

Get music

Read a CD

Rename tracks

Listen to music

See Memory card playback

Copy to

Nokia Music Player
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 CD Manager - Pomoc

 – gdzie jej szukaæ?
aj±c z programu Nokia CD Manager, postêpuj ¶ci¶le z instrukcjami. Je¶li czego¶ ni
j przycisk prawym przyciskiem myszy w obrêbie okna aplikacji i wybierz Help, aby 
do plików pomocy online i wybraæ odpowiadaj±c± zagadnieniu pozycjê. Pliki pom
iaj± dostêp do szczegó³owych instrukcji dla wszystkich zadañ, które mo¿na wykon
amie Nokia CD Manager, jak i dla dodatkowych zadañ nie wymienionych w tym p
waga: Po wykonaniu instalacji warto zapoznaæ siê z plikiem pomocy online.
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Aby otworzyæ listê pozycji pomocy, kliknij dwukrotnie ikonê ksi±¿ki w lewym panelu. Nast
interesuj±cy ciê temat, aby w prawym panelu wy¶wietliæ tekst pomocy.
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Kliknij jeden z przycisków w prawym panelu, w wyniku czego pojawi siê rozwijalne okno z
pomocy.
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 CD Manager

. Pobieranie muzyki
enu 'Start wybierz ikonê programu Nokia CD Manager. Pojawi siê poni¿sze okno:

ystkie pliki d¼wiêkowe w komputerze pokazane bêd± z lewej strony okna, a wszystkie
iêkowe w urz±dzeniu – z prawej strony okna. Je¶li urz±dzenie nie jest pod³±czone do 
zie to uwidocznione w kolumnie z prawej strony okna.
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k 2. Odczytywanie p³yty CD
"Read CD" odnosi siê do procesu kopiowania utworów z p³yty CD-ROM na dysk twardy ko
odczytaæ p³ytê CD, nale¿y w³o¿yæ j± do w³a¶ciwego napêdu i uruchomiæ program Nokia CD
Klawiszem 'Shift' wybierzesz nieprzerwany ci±g plików, a klawiszem 'Ctrl' wybierzesz poje

Kliknij przycisk , aby otworzyæ okno dialogowe CD Transfer. Wyd³u¿aj±cy siê 
wskazywa³ stopieñ zaawansowania operacji.
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k 3.  Zmiana nazw utworów
Prawym przyciskiem myszy kliknij nazwê pliku w oknie Track List Box. W oknie Edit Box p
nazwa wybranego pliku. 

W tym oknie mo¿esz zmieniæ pokazan± nazwê. Nazwa musi byæ unikatowa, bo inny utwó
nazwie nie mo¿e istnieæ w komputerze lub w odtwarzaczu Nokia Music Player. 

Uwaga: W nazwie pliku nie powinny znale¼æ siê nastêpuj±ce znaki: / \ : * ? " < > !

Aby zakoñczyæ operacjê, kliknij Rename.
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k 4. Kopiowanie do odtwarzacza i ods³uchiwanie muzyki
Z lewej strony ekranu zaznacz pliki, które chcesz przes³aæ do odtwarzacza Nokia Music Pl
Klawiszem Shift zaznaczysz nieprzerwany ci±g plików, a klawiszem Ctrl – pojedyncze plik

Kliknij przycisk , aby skopiowaæ pliki do odtwarzacza Nokia Music Player.

(Patrz punkt Nokia Music Player, karta pamiêci – odtwarzanie).
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k 5. Korzystanie z menu

ia On PC – klikniêcie prawym klawiszem myszy
Klikniêcie prawym klawiszem myszy dowolnej pozycji z listy Media On PC spowoduje poj
poni¿szego menu:

Zmiana katalogu w PC

Program Audio Manager domy¶lnie zapisuje pliki d¼wiêkowe na dysku C: komputera. Aby 
katalog, kliknij prawym przyciskiem myszy w oknie programu Nokia CD Manager i wybierz
Directory…

Od¶wie¿anie urz±dzenia

Od¶wie¿ okno z list± Media On PC lub Media On Device.

Formatowanie urz±dzenia

Aby sformatowaæ kartê pamiêci odtwarzacza Nokia Music Player, kliknij prawym przyciski
w oknie Nokia CD Manager i wybierz Format Device…

Uwaga: W wyniku formatowania karty pamiêci odtwarzacza, wszystkie utwory muz
zostan± utracone!
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Odczytywanie p³yty CD

Program Nokia CD Manager rozpocznie odczytywanie p³yty audio CD.

Usuwanie pliku

Prawym klawiszem myszy kliknij nazwê pliku, który chcesz usun±æ. 

Zmiana nazwy pliku

Prawym klawiszem myszy kliknij nazwê pliku, którego nazwê chcesz zmieniæ. 

Pomoc

Opcja Help otworzy dostêp do tekstów pomocy. 

Zamkniêcie programu

ClosePrzycisk zamyka program Nokia CD Manager.

ia On Device – klikniêcie prawym klawiszem myszy
Klikniêcie jednego z plików w oknie Media On Device otworzy nastêpuj±ce menu:
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Zmiana katalogu w PC
Program Nokia CD Manager domy¶lnie zapisuje pliki medialne na dysku C: komputera. Ab
miejsce zapisu (katalog), kliknij prawym przyciskiem myszy w oknie Nokia CD Manager i w
Change PC Directory…

Od¶wie¿anie urz±dzenia
Od¶wie¿ okno Media On PC lub Media On Device

Formatowanie urz±dzenia
Aby sformatowaæ kartê pamiêci odtwarzacza Nokia Music Player, kliknij prawym przyciski
w oknie Nokia CD Manager i wybierz Format Device…

Uwaga: W wyniku formatowania karty pamiêci odtwarzacza, wszystkie zapisane na
utwory zostan± utracone!

Odczytywanie p³yty CD
Program Nokia CD Manager rozpocznie odczytywanie p³yty audio CD.

Rename_track

W oknie Media On Device nie mo¿na zmieniæ nazwy utworu.

Usuwanie pliku

Prawym klawiszem myszy kliknij nazwê pliku, który chcesz usun±æ. 

Pomoc

Opcja Help otworzy dostêp do tekstów pomocy. 

Zamkniêcie programu

Przycisk Close zamyka program Nokia CD Manager.
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k 6. Kopie zapasowe i przywracanie utworów muzycznych
Funkcja ta bêdzie dostêpna w niedalekiej przysz³o¶ci. Wiêcej na ten temat przeczytasz na s
club.nokia.com.

http://www.club.nokia.com/
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 Music Player, karta pamiêci – odtwarzanie

pamiêci – sterowanie odtwarzaniem
 omówiono szczegó³y dotycz±ce odtwarzania muzyki z karty pamiêci. O kopiowan
ê pamiêci przeczytasz w punkcie Przesy³anie plików muzycznych do karty d¼wiêko

anager) lub w punkcie Kopiowanie do odtwarzacza i ods³uchiwanie muzyki (Noki
r).

W³±czanie odtwarzacza muzyki

Prze³±cznik audio/off ustaw w pozycji audio. 

Uwaga: Je¶li nie w³o¿ono karty pamiêci lub zrobiono to nieprawid³ow
siê komunikat . Je¶li karta pamiêci jest pusta, po
komunikat .

Wybieranie odtwarzania z karty pamiêci

Je¿eli odtwarzacz by³ ostatnio u¿ywany do odtwarzania z karty pamiêci, po
komunikat:

li odtwarzacz by³ ostatnio u¿ywany do s³uchania radia FM, pojawi siê komunikat:

waga: Odtwarzacz Nokia Music Player jest dostarczany wraz z oprogramowaniem
(Firmware Version 1.00). Wiêcej na temat uaktualniania oprogramowania m
przeczytaæ w punkcie Uaktualnianie – odtwarzacz Nokia Music Player (p
uaktualniania czêsto dodawane s± nowe funkcje).

NoMedia

NoTracks

MusicOn V 1.00 Digital

MusicOn V 1.00 FM
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Aby prze³±czyæ tryb odtwarzania z radia FM na odtwarzanie z karty pam
przytrzymaj przycisk mode przez kilka sekund do momentu pokazania siê

 i nazwy listy utworów. 

Uwaga: Je¿eli na karcie pamiêci nie zapisano ¿adnej nazwy listy u
pojawi siê komunikat .

Regulacja g³o¶no¶ci

Poziom g³o¶no¶ci ustawisz, naciskaj przycisk regulacji w górê + lub w dó³ –

Minimum

Maksimum

Uwaga: Poziom g³o¶no¶ci jest zapamiêtywany przez odtwarzacz Nokia Music Playe
wznowieniu odtwarzania poziom g³o¶no¶ci powraca do ostatniego ustawie

e

Digital

Unknown

-

+
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Odtwarzanie

Naci¶nij . Rozpocznie siê odtwarzanie pierwszego utworu z karty pamiêci, a przez pie
sekund na wy¶wietlaczu bêdzie siê przewija³ tytu³ utworu; nastêpnie pojawi siê czas trwa

Przerwa w odtwarzaniu

Aby przerwaæ odtwarzanie, naci¶nij . Pulsowaæ bêdzie czas odtwarzania i nuty muzy

Uwaga: Odtwarzacz pozostawiony przez trzy minuty w trybie pauzy prze³±czy siê n
energooszczêdny tryb u¶pienia. 

Kontynuowanie odtwarzania

Je¶li chcesz po przerwie wznowiæ odtwarzanie, naci¶nij . 

Music titl

Pulsuje podczas odtwarzania

02:15
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Zakoñczenie odtwarzania/wy³±czanie

Prze³±cznik audio/off ustaw w pozycji off. 

Wybór utworu do odtwarzania

Przej¶cie do innego utworu

Podczas odtwarzania lub pauzy naci¶nij krótko . Po ka¿dym naci¶niêc
rozpocznie siê odtwarzanie kolejnego utworu, którego numer pojawi siê 
wy¶wietlaczu. 

Powrót do pocz±tku utworu

Po up³ywie dwóch lub wiêcej sekund odtwarzania, naci¶nij na krótko . Utwór bêdzie w
odtwarzany od pocz±tku.

Przej¶cie do poprzedniego utworu

Po up³ywie dwóch lub wiêcej sekund odtwarzania, naci¶nij szybko i dwukrotnie . Odtw
przejdzie do poprzedniego utworu, którego numer pojawi siê na wy¶wietlaczu.
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nowanie utworów
y utwór mo¿esz szybko przewijaæ do przodu i do ty³u.

Przewijanie do przodu

Podczas odtwarzania lub pauzy naci¶nij i przytrzymaj . Kiedy naciskasz i przytrzymujes
, odtwarzacz przewija utwór do przodu, odtwarzanie jest wyciszone, a licznik odmierza

odtwarzania. Gdy zwolnisz przycisk , odtwarzanie rozpocznie siê na nowo.

Przewijanie utworu do ty³u

Podczas odtwarzania lub pauzy naci¶nij i przytrzymaj . Kiedy naciskasz i przytrzymujes
odtwarzacz przewija utwór do ty³u, a licznik odmierza malej±cy czas odtwarzania. Gdy zwo

, odtwarzanie rozpocznie siê na nowo.

2623
02:24

2425

2425
03:24

2623
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ór opcji odtwarzania

Jednokrotne odtwarzanie wszystkich utworów

Naci¶nij mode. Pojawi siê komunikat . W ci±gu kilku sekund naciskaj kilkakro
 a¿ do momentu pojawienia siê komunikatu . 

Powtórne odtwarzanie wszystkich utworów

Naci¶nij mode. Pojawi siê komunikat . W ci±gu kilk
naciskaj kilkakrotnie  lub  a¿ do momentu pojawienia siê

. 

Powtórne odtwarzanie jednego utworu

S³uchaj±c utworu, który chcia³by¶ us³yszeæ ponownie, naci¶nij m
siê komunikat . W ci±gu kilku sekund naciskaj kilka
lub  a¿ do momentu pojawienia siê komunikatu 

Odtwarzanie wszystkich utworów w losowej kolejno¶ci

Naci¶nij mode. Pojawi siê komunikat . W ci±gu kilk
naciskaj kilkakrotnie  lub  a¿ do momentu pojawienia siê

. 

Play>>

Play-1

de

Play>>

Rep-ALL

Play>>

Rep-1

Play>>

Random
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ór brzmienia odtwarzania
wzmocnienia ró¿nych tonów odtwarzanej muzyki masz do wyboru piêæ ró¿nych usta
ienia. S± to: Normal, Classic, Rock, Jazz, or Custom. W trybie Custom mo¿na ustawiæ

le. Aby cieszyæ siê s³uchan± muzyk±, wybierz takie jej brzmienie, które najbardziej pa
aju odtwarzanego utworu.

Wybór brzmienia

W trakcie odtwarzania lub pauzy naci¶nij dwukrotnie mode. Poj
komunikat . W ci±gu kilku sekund naci¶nij kilkakrot

, aby wybraæ ¿±dane ustawienie brzmienia: , 
,  lub . Muzyka bêdzie odt

zgodnie z wybranym ustawieniem.

Wybór brzmienia Custom

W trakcie odtwarzania lub pauzy naci¶nij dwukrotnie mode. Poj
komunikat . Aby wybraæ , w ci±gu kilku
naciskaj kilkakrotnie  lub . W ci±gu kilku sekund naci¶nij 
mode. Wy¶wietlany komunikat zmieni siê na  lub 
W ci±gu kilku sekund naci¶nij kilkakrotnie  lub , aby wyb

 i .

de

Tone>>

Normal

Rock Jazz Custom

Tone>> Custom

Treble

Treble Bass
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Nastawianie Bass i Treble

W trakcie wy¶wietlania komunikatu  lub  naci¶nij 
nastêpnie naci¶nij przycisk regulacji g³o¶no¶ci w górê + lub w dó³ –, aby us
(basy) lub Treble (soprany).

Bass (basy)

Treble (soprany)

-

+

Normal

Tone>>

Treble

Bass

Classic

Rock

Jazz

Custom

mode (2x)

mode
mode

mode
B

T

mode

Treble Bass

B

T
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cisk blokady
cisk ten blokuje klawisze odtwarzacza Nokia Music Player, co zapobiega przypadkow
¶niêciom klawiszy, gdy odtwarzacz jest noszony np. w kieszeni. 

Blokowanie klawiszy

Po ustawieniu odtwarzacza tak jak lubisz, przesuñ hold w kierun
Pojawi siê komunikat . Wszystkie klawisze zostan± z

Uwaga: Nadal mo¿na odbieraæ i nawi±zywaæ po³±czenia z
Nokia (pod³±czonego do odtwarzacza), naciskaj±c
przycisk .

Je¿eli pozostawisz odtwarzacz Nokia Music Playe
u¶pienia i zablokujesz przyciski, mo¿esz wznowiæ 
odtwarzanie, naciskaj±c .

Odblokowanie klawiszy

Aby odblokowaæ klawisze, przesuñ hold w kierunku strza³ki. Klaw
odblokowane.

d

HOLD

d
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¶wietlanie wy¶wietlacza
wietlacz bêdzie pod¶wietlony przez kilka sekund po ka¿dym naci¶niêciu dowolnego kl
ic Player. Aby w³±czyæ pod¶wietlanie wy¶wietlacza, naci¶nij i przytrzymaj . Wy¶w
anie pod¶wietlony. Gdy zwolnisz przycisk , pod¶wietlenie zga¶nie.

Naci¶nij i
przytrzymaj
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 Music Player – Strojenie radia FM

usic Player odbiera równie¿ audycje stereo radia FM. Aby¶ móg³ s³uchaæ radia FM
do odtwarzacza Nokia Music Player i pod³±cz kabel s³uchawek. Je¶li nie wiesz jak
do punktu Nokia Music Player – Pierwsze kroki.
waga: Kabel s³uchawek s³u¿y te¿ jako antena radia FM. Je¶li chcesz pod³±czyæ i u¿

innego kabla s³uchawek, upewnij siê, czy ma tak± sam± d³ugo¶æ jak kabel o

W³±czanie odtwarzacza muzyki

Prze³±cznik audio/off ustaw w pozycji audio. 

Prze³±czanie odtwarzacza na radio FM

Je¿eli odtwarzacz by³ ostatnio u¿ywany do s³uchania radia FM, pojawi siê k

Je¿eli odtwarzacz by³ ostatnio u¿ywany do odtwarzania z karty pamiêci, po
komunikat:

MusicOn V 1.00 FM

MusicOn V 1.00 Digital
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Aby prze³±czyæ urz±dzenie z odtwarzania z karty pamiêci na odtwarzanie
naci¶nij i przytrzymaj przycisk mode przez kilka sekund, a¿ pojawi siê ko

. Zostanie wy¶wietlona ostatnio wybrana czêstotliwo¶æ stac
Je¿eli czêstotliwo¶æ odpowiada konkretnej stacji FM, us³yszysz nadawan
audycjê.

Regulacja g³o¶no¶ci

Poziom g³o¶no¶ci ustawisz, naciskaj przycisk regulacji w górê + lub w dó³ –

Minimum

Maksimum

Uwaga: Poziom g³o¶no¶ci jest zapamiêtywany przez odtwarzacz Nokia Music Playe
wznowieniu odtwarzania poziom g³o¶no¶ci powraca do ostatniego ustawie

e

FM

FM99.9

-

+
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ór czêstotliwo¶ci

Wybór wy¿szej czêstotliwo¶ci

Naci¶nij na krótko . Czêstotliwo¶æ wzrasta o 100 Hz i jest warto¶ci s± widoczne na wy
Krótkimi naci¶niêciami klawisza  ustaw ¿±dan± czêstotliwo¶æ.

Wybór ni¿szej czêstotliwo¶ci

Naci¶nij na krótko . Czêstotliwo¶æ maleje o 100 Hz i jej warto¶ci s± widoczne na wy¶w
Krótkimi naci¶niêciami klawisza  ustaw ¿±dan± czêstotliwo¶æ.

zystanie z funkcji automatycznego wyszukiwania czêstotliwo¶ci FM
ia Music Player potrafi sam znale¼æ stacjê radiow± FM o dostatecznie silnym sygnale

Automatyczne wyszukiwanie wy¿szych czêstotliwo¶ci

Naci¶nij i przytrzymaj przycisk . Zmiany czêstotliwo¶ci bêd± wy¶wietlane po rozpoczêc
wyszukiwania. Zwolnij przycisk . Nokia Music Player automatycznie wyszukuje czêstot
momentu znalezienia stereofonicznej stacji radiowej o sile sygna³u odpowiedniej dla dobr
Gdy ju¿ odpowiednia stacja zostanie znaleziona, czêstotliwo¶æ przestanie siê zmieniaæ. 

FM100.0 FM100.1

FM100.0FM100.1

11
FM110.2

33
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Automatyczne wyszukiwanie ni¿szych czêstotliwo¶ci

Naci¶nij i przytrzymaj przycisk . Zmiany czêstotliwo¶ci bêd± wy¶wietlane po rozpoczêc
wyszukiwania. Zwolnij przycisk . Nokia Music Player automatycznie wyszukuje czêstot
momentu znalezienia stereofonicznej stacji radiowej o sile sygna³u odpowiedniej dla dobr
Kiedy odpowiednia stacja zostanie znaleziona, czêstotliwo¶æ przestanie siê zmieniaæ. 

wanie funkcji zapamiêtywania stacji
na ustawiæ do piêciu ulubionych stacji FM dla u³atwienia ich wywo³ania.

Wybór czêstotliwo¶ci

Po nastawieniu danej stacji naci¶nij dwukrotnie przycisk mode. 
komunikat , a po dwóch sekundach – kolejny komu

. 

Programowanie kana³ów

Podczas wy¶wietlania komunikatu  naci¶nij  lub
przydzieliæ stacjê radiow± do kana³u od CH1 do CH5.  

Po zaprogramowaniu kana³ów od CH1 do CH5 naci¶nij mode. P
komunikat . Wybrana czêstotliwo¶æ zosta³a zapisan

33
FM115.2

11

de

Memory

Select

Select

Select Select

Yes
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Wywo³ywanie zaprogramowanej czêstotliwo¶ci

Naci¶nij przycisk . Po ka¿dym naci¶niêciu przycisku  zostan± wy¶wietlone zapro
kana³y wraz z zapisanymi w pamiêci czêstotliwo¶ciami. 

Wy¶wietlony te¿ bêdzie wywo³any kana³ i jego czêstotliwo¶æ. Po dwóch sekundach us³ysz
wybranej czêstotliwo¶ci.

³±czanie miêdzy trybem stereo a mono
ami interferencje radiowe lub s³aby sygna³ mog± powodowaæ zak³ócenia w odbiorze.
ryb mono mo¿e poprawiæ odbiór.

Wybór trybu mono

Podczas s³uchania radia naci¶nij na krótko przycisk mode. Zostanie wy¶wietlony status try
mono. Aby wy¶wietliæ , naci¶nij  lub . D¼wiêk stanie siê monofoniczny

Wybór trybu stereo

Podczas s³uchania radia naci¶nij na krótko przycisk mode. Zostanie wy¶wietlony status try
mono. Naci¶nij  lub , aby wy¶wietliæ . D¼wiêk stanie siê stereofoniczny

FM100.0FM 99.1

Mono

Stereo
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 Music Player – korzystanie z mikro-zestawu

³±czysz Nokia Music Player do telefonu Nokia, bêdziesz móg³ z niego korzystaæ be
s s³uchania muzyki mo¿na odbieraæ po³±czenia i prowadziæ rozmowy bez dotykani

o¿liwo¶ci wybierania g³osowego mo¿na te¿ nawi±zywaæ po³±czenia bez dotykan
waga: Funkcja wybierania g³osowego jest dostêpna w telefonach Nokia 3310, 333

8890.

elefony mog± byæ u¿ywane razem z odtwarzaczem Nokia Music Playe
elefony Nokia s± tak zaprojektowane, aby mog³y wspó³dzia³aæ z odtwarzaczem Nokia 
 pod³±czaj odtwarzacza Nokia Music Player do innych telefonów.

okia 8210 Nokia 3310, 3330 Nokia 8850, 8890 Nokia 82
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warzacz Nokia Music Player w po³±czeniu z telefonem

Zdejmowanie pokrywy z³±cza Phone/PC

Otwórz pokrywê z³±cza Phone/PC. Otwarta pokrywa z³±cza Phon
pozostaje przy odtwarzaczu Nokia Music Player.

Uwaga: Pokrywa ta jest przymocowana do odtwarzacza. N
jej usun±æ.

Aby zapobiec dostaniu siê kurzu, brudu lub wilgo
z³±cza do Phone/PC w odtwarzaczu Nokia Music 
zawsze zamykaj pokrywê z³±cza, gdy go nie u¿yw

Pod³±czanie odtwarzacza Nokia Music Player

Pod³±cz kabel telefonu do z³±cza Phone/PC, staraj±c siê dopasow
kabla do z³±cza. 

Uwaga: B±d¼ ostro¿ny podczas pod³±czania i od³±czania k
Zawsze chwytaj kabel za jego grubszy fragment, 
metalow± wtyczk±. Nigdy nie wk³adaj ani nie wyj
kabla, trzymaj±c go lub ci±gn±c za sam tylko prze

ze 
ne/PC
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Odtwarzacz w po³±czeniu z telefonem Nokia

Pod³±cz kabel telefonu do z³±cza w telefonie komórkowym Nokia. Po³o¿enie z³±cza trochê
w ró¿nych modelach telefonów.

* Uwaga: Uwa¿aj, aby nie uszkodziæ z³±cza kabla telefonu, gdy otwierasz lub zamyka
przesuwan± obudowê telefonu.

Nokia 8210 Nokia 3310, 3330

Nokia 8850*, 8890* Nokia 8250



No

87 a Mobile Phones.
awa zastrze¿one.

Odb
Korz o¿na 
odbi e po³±czenie, 
w s³ nawi±zujesz 
po³± Nokia Music 
Play

lefonach 

est zbyt 
æ siê 
lno¶æ, 
¶ci 15 cm 

ony, 
elefonem 
uchawce. 

as 
ny, aby 
kia Music Player – korzystanie z mikro-zestawu

Copyright © 2001 Noki
Wszelkie pr

ieranie i nawi±zywanie po³±czeñ
ystaj±c z odtwarzacza Nokia Music Player i pod³±czonego do niego telefonu Nokia m
eraæ i nawi±zywaæ po³±czenia bez u¿ycia r±k. Je¶li podczas s³uchania muzyki nadejdzi
uchawkach us³yszysz d¼wiêk dzwonka, a muzyka zostanie wyciszona. Natomiast gdy 
czenie, odtwarzacz Nokia Music Player automatycznie wyciszy muzykê. Odtwarzacz 
er ma ponadto mikrofon, który pozwala rozmawiaæ bez dotykania telefonu.

Uwaga: Funkcja wybierania g³osowego jest dostêpna w te
Nokia 3310, 3330, 8250 i 8890.

Je¿eli mikrofon odtwarzacza Nokia Music Player j
daleko od ust, wówczas do mikrofonu mo¿e dosta
ha³as z otoczenia. Aby osi±gn±æ optymaln± s³ysza
umie¶æ odtwarzacz Nokia Music Player w odleg³o
od ust.

Je¿eli odtwarzacz Nokia Music Player jest wy³±cz
mo¿na nadal odbieraæ i nawi±zywaæ po³±czenia t
Nokia, ale d¼wiêk bêdzie s³yszalny tylko w lewej s³
Je¿eli bateria jest wyczerpana lub jej brak, wówcz
odtwarzacz Nokia Music Player musi byæ wy³±czo
mo¿na by³o nawi±zywaæ i odbieraæ po³±czenia.

15 cm
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ieranie po³±czeñ

Odbieranie po³±czenia

Je¿eli telefon dzwoni podczas s³uchania muzyki, sygna³ dzwonka s³ychaæ w s³uchawce. Po
komunikat . Naci¶nij i przytrzymaj przez sekundê przycisk . Muzyka zostanie
odtwarzanie muzyki z karty pamiêci przejdzie w tryb pauzy. Mo¿na wtedy rozpocz±æ rozm
W s³uchawce bêdzie s³yszalny g³os rozmówcy.

Zakoñczenie po³±czenia

Po zakoñczeniu rozmowy ponownie naciskaj przez sekundê przycisk . Po³±czenie zostanie
a odtwarzanie bêdzie kontynuowane.

Uwaga: Aby wyd³u¿yæ czas s³uchania muzyki przy korzystaniu z baterii, wy³±cz odtw
Nokia Music Player, kiedy go nie u¿ywasz. Gdy odtwarzacz bêdzie wy³±czon
bêdzie mo¿na rozmawiaæ przez telefon (s³uchawka, mikrofon).

i±zywanie po³±czeñ
esz z ³atwo¶ci± nawi±zywaæ po³±czenia telefoniczne, nawet je¶li telefon Nokia trzym
eszeni. Oznacza to, ¿e u¿ywaj±c zarówno mikro-zestawu jak i opcji wybierania g³oso
iesz móg³ nawi±zywaæ po³±czenia, nie dotykaj±c telefonu. Wiêcej na temat wybierani
czytasz w instrukcji obs³ugi telefonu Nokia.

Uwaga: Funkcja wybierania g³osowego w po³±czeniu z odtwarzaczem Nokia Music P
dostêpna w telefonach Nokia 3310 i 8890.

Phone
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Aktywacja telefonu

Naci¶nij i przytrzymaj przez sekundê przycisk . Muzyka zostanie wyciszona, a odtwarzan
z karty pamiêci przejdzie w tryb pauzy. W s³uchawce bêdzie s³yszalny sygna³ linii telefonic
siê komunikat . 

Wybieranie g³osowe

Wypowiedz nazwê przypisan± do jednego z numerów zapisanych w telefonie Nokia. Rozpo
zostanie odtworzona w s³uchawce, a po chwili zarejestrowany numer bêdzie ju¿ wybrany. 
przez telefon, mów tak, jak zwykle.

Uwaga: Je¿eli telefon nie rozpozna wypowiedzianej nazwy, s³uchawka zasygnalizuj
Ponów próbê, zaczynaj±c od kroku Activate your phone.

Wiêcej o wybieraniu g³osowym przeczytasz w instrukcji obs³ugi telefonu.

Zakoñczenie po³±czenia

Po zakoñczeniu rozmowy ponownie naci¶nij przycisk . Po³±czenie zostanie zakoñczone, a
bêdzie kontynuowane.

Phone
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 Music Player – Prze³±czanie bez u¿ycia r±k

 ró¿ne sposoby odbierania i zakoñczenia po³±czeñ, podczas gdy telefon jest pod³±
zacza. Poni¿ej omówiono poszczególne sposoby. Przeczytaj instrukcjê obs³ugi tele
iej zapoznaæ siê z jego funkcjami.

anie po³±czeñ
eranie po³±czenia Zakoñczenie po³±czenia Rezultat

nij Naci¶nij Oto zalecany sposób korzystania z funkcji prze³
u¿ycia r±k. Kiedy naciskasz przycisk , aby odeb
muzyka jest wyciszona. W przypadku gdy muzy
odtwarzana z karty pamiêci, wówczas urz±dzen
w tryb pauzy.

nij Naci¶nij End Kiedy naciskasz przycisk , aby odebraæ po³±cze
wyciszona. W przypadku gdy muzyka jest odtw
pamiêci, wówczas urz±dzenie przechodzi w tryb
naci¶niêciu przycisku End po³±czenie zostanie z
w ci±gu piêciu do dziesiêciu sekund odtwarzan
na nowo. Pocz±tkowo cicho, a w miarê up³ywu 
g³o¶no¶ci bêdzie wzrasta³ a¿ do osi±gniêcia poz
ustawionego przed po³±czeniem.

nij Answer Naci¶nij Po naci¶niêciu przycisku Answer g³os rozmówcy
jednocze¶nie z odtwarzan± muzyk±. Tego typu p
nazywa siê Music Call (po³±czenie z muzyk± w 
naci¶niêciu przycisku  po³±czenie zostanie zak
odtwarzanie muzyki bêdzie kontynuowane.

nij Answer Naci¶nij End Po naci¶niêciu przycisku Answer g³os rozmówcy
jednocze¶nie z odtwarzan± muzyk±. Tego typu p
nazywa siê Music Call (po³±czenie z muzyk± w 
naci¶niêciu przycisku End po³±czenie zostanie z
a odtwarzanie muzyki bêdzie kontynuowane.
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i±zywanie po³±czeñ

ieranie wiadomo¶ci SMS

Wysy³anie wiadomo¶ci SMS

awi±zanie po³±czenia Zakoñczenie po³±czenia Rezultat

aci¶nij Call Naci¶nij End Po naci¶niêciu przycisku Call telefon wybiera n
ale g³os rozmówcy bêdzie s³yszany jednocze¶nie
muzyk±. Tego typu po³±czenie nazywa siê Music
z muzyk± w tle) Po naci¶niêciu przycisku End p
zostanie zakoñczone, a odtwarzanie muzyki bêd
kontynuowane.

aci¶nij Call Naci¶nij Po naci¶niêciu przycisku Call telefon wybiera n
ale g³os rozmówcy bêdzie s³yszany jednocze¶nie
muzyk±. Tego typu po³±czenie nazywa siê Music
z muzyk± w tle) Po naci¶niêciu przycisku  po³±
odtwarzanie zostan± zakoñczone. Ponownie na
kontynuowaæ s³uchanie muzyki.

Rezultat

aci¶nij Read Wybrany sygna³ nadej¶cia wiadomo¶ci SMS mo
w s³uchawkach. Aby odbieraæ i odczytywaæ wia
mo¿esz korzystaæ z telefonu jak zwykle. 

Rezultat

aci¶nij Send Korzystaj z telefonu jak zwykle, aby redagowaæ
wiadomo¶ci SMS, ale w s³uchawkach d¼wiêki k
s³yszalne.
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ieranie g³osowe

Inne telefony komórkowe firmy Nokia, które obs³uguj± funkcjê wybierania g³osowego

ybieranie g³osowe Zakoñczenie po³±czenia Rezultat

aci¶nij  i przytrzymaj Naci¶nij Naci¶nij i przytrzymaj przez kilka sekund . Mu
wyciszona, a odtwarzanie muzyki z karty pamiê
w tryb pauzy. W s³uchawce bêdzie s³yszalny syg
telefonicznej. Pojawi siê komunikat 

Wypowiedz nazwê przypisan± do jednego z num
zapisanych w telefonie Nokia. Rozpoznana nazw
odtworzona w s³uchawce, a po chwili zarejestro
bêdzie ju¿ wybrany. Rozmawiaj±c przez telefon
zwykle.

Po zakoñczeniu rozmowy ponownie naci¶nij prz
Po³±czenie zostanie zakoñczone, a odtwarzanie
kontynuowane.

ktywacja wybierania 
³osowego

Naci¶nij End Aby wybraæ g³osowo jaki¶ numer, trzeba najpie
odtwarzacz Nokia Music Player. Wiêcej o wybie
przeczytasz w instrukcji obs³ugi telefonu Nokia
po³±czenia mo¿na ponownie w³±czyæ odtwarza
Player. 

ybieranie g³osowe Zakoñczenie po³±czenia Rezultat

ktywacja wybierania 
³osowego

Naci¶nij End Aby wybraæ g³osowo jaki¶ numer, trzeba najpie
odtwarzacz Nokia Music Player. Wiêcej o wybie
przeczytasz w instrukcji obs³ugi telefonu Nokia
po³±czenia mo¿na ponownie w³±czyæ odtwarza
Player. 

Phone
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ulacja g³o¶no¶ci i Music Call (po³±czenie z muzyk± w tle)

Ustawienia g³o¶no¶ci w telefonie Nokia i w odtwarzaczu Nokia Music Player

Je¿eli odbierasz lub nawi±zujesz po³±czenia z funkcj± Music Call (po³±czenie z muzyk± w 
rozmówcy jest zmiksowany ze s³uchan± muzyk± o ustawionej w telefonie g³o¶no¶ci. Je¿el
rozmowy korzystasz z regulatorów g³o¶no¶ci odtwarzacza Nokia Music Player, wówczas g
muzyki i g³osu rozmówcy jest ustawiana jednocze¶nie. Gdy g³os rozmówcy jest ledwo s³ys

1. Obni¿ poziom g³o¶no¶ci, korzystaj±c z regulatorów odtwarzacza Nokia Music Player.

2. U¿ywaj±c regulatorów g³o¶no¶ci w telefonie, zwiêksz poziom g³o¶no¶ci g³osu rozmówcy

Zalecane jest nastawianie telefonu na niski poziom g³o¶no¶ci. Gdy nadejdzie po³±czenie, b
wówczas mo¿na zmniejszyæ g³o¶no¶æ w odtwarzaczu Nokia Music Player. Poziom g³o¶no¶
w odtwarzaczu Nokia Music Player i w telefonie Nokia zostanie obni¿ony. Nastêpnie zwiê
g³o¶no¶ci w telefonie, tym samym zwiêkszaj±c g³o¶no¶æ g³osu rozmówcy.
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 Music Player – Bateria

óki odtwarzacz Nokia Music Player jest zasilany z baterii, wy¶wietlany bêdzie wska¼ni
dowania. 

wy¶wietlaczu pojawi siê piêæ pasków, je¿eli bateria jest w pe³ni na³adowana. W miarê 
adowywania siê baterii zmniejsza siê liczba wy¶wietlanych pasków.

li wska¼nik na³adowania baterii nie wy¶wietla pasków, urz±dzenie bêdzie jeszcze dzia
³o piêæ minut. W momencie ca³kowitego roz³adowania baterii zostanie wy¶wietlony kom
TERY, a odtwarzacz Nokia Music Player wy³±czy siê. Zanim bateria nie zostanie wymi

warzacza nie da siê w³±czyæ. O wymianie baterii przeczytasz w punkcie Instalowanie b

BATTERYLOW
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gi koñcowe – oszczêdzanie energii
• W normalnych warunkach jedna bateria alkaliczna AAA zasila odtwarzacz energi±, któr

do odtwarzania muzyki z karty pamiêci przez oko³o piêæ godzin.
• W zimnym klimacie ¿ywotno¶æ baterii bêdzie znacznie krótsza i dostarczy urz±dzeniu e

wystarczaj±cej na zaledwie parê godzin Odtwarzacz wówczas nale¿y przykryæ i u¿ywaæ
miejscu.

• Pozostawienie baterii w gor±cych lub zimnych miejscach, takich jak zamkniêty samoch
zim±, spowoduje zmniejszenie jej pojemno¶ci i ¿ywotno¶ci. Staraj siê zawsze przechow
w temperaturze od 15°C do 25 °C (od 59°F do 77°F). Je¿eli bêdziesz korzysta³ z przegrza
wych³odzonej baterii, odtwarzacz Nokia Music Player mo¿e chwilowo nie dzia³aæ, nawe
jest w pe³ni na³adowana.

• Mimo ¿e mo¿na s³uchaæ muzyki podczas po³±czenia, to dla oszczêdno¶ci energii dobrze 
odtwarzacz, szczególnie je¶li jest to d³u¿sza rozmowa. Patrz punkt Prze³±czanie bez u¿

• Zawsze wybieraj baterie wysokiej jako¶ci i wiadomego pochodzenia. 
• Najbardziej zalecane s± baterie alkaliczne z uwagi na ich d³ug± ¿ywotno¶æ. Mo¿na tez u

NiMH. Nie u¿ywaj natomiast baterii Ni-Cad, manganowych, z tlenkiem manganu ani ba
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 Audio Manager – Komunikaty o b³êdach

ie: Kiedy próbujê odczytaæ p³ytê CD, pojawia siê komunikat o b³êdzie. Co to oznacza
ied¼:Oznacza to, ¿e pojawi³ siê b³±d w trakcie kopiowania danych z napêdu CD-ROM

przycisk Configure it for me w oknie pozycji menu View > Options> ReadCD i
program Nokia Audio Manager wybra³ najlepsze ustawienia. 

ie: Gdy po raz pierwszy uruchomiony zosta³ program Nokia Audio Manager, pojawi³ s
o tre¶ci: “Some of this program’s file types are no longer associated with it.”
oznacza? Dlaczego wci±¿ siê to powtarza?

ied¼:Program Nokia Audio Manager obs³uguje ró¿ne rodzaje plików. Mo¿na wybraæ f
automatycznego otwierania ró¿nych typów plików i uruchamiania ich w program
Audio Manager. Nale¿y przej¶æ do okna pozycji menu View > Options > File Ty
zaznaczyæ pliki, z których chcesz uruchomiæ program Nokia Audio Manager. 
Je¿eli jednak komunikat wci±¿ siê pojawia, mo¿e to oznaczaæ, ¿e inna aplikacja 
przejmuje zwi±zek z tymi plikami, kiedy wychodzisz z programu Nokia Audio Ma

ie: Kiedy klikam click copy to devices, pojawia siê komunikatUnable to communic
portable device. Co trzeba zrobiæ?

ied¼:Je¿eli pojawia siê taki komunikat, nale¿y sprawdziæ kilka rzeczy:

• Sprawdziæ, czy bateria w odtwarzaczu Nokia Music Player nie zosta³a wyczerpana. (Patr
Music Player – Bateria).

• Sprawdziæ, czy odtwarzacz Nokia Music Player jest pod³±czony prawid³owo i czy jest w³±
punkt Pod³±czanie odtwarzacza do komputera). 

• Sprawdziæ, czy na pulpicie komputera My Computer > Control Panel > System > Devi
Universal Serial Bus Controller wymieniony jest odtwarzacz Nokia Music Player. Nazwa
znale¼æ siê na li¶cie to Nokia Music Player HDR-1 Nokia Mobile Phones Ltd. Kliknij n
sie na li¶cie urz±dzeniu i sprawd¼ jego stan (Device Status). W³a¶ciwy stan urz±dzenia t
Properly. Je¿eli urz±dzenia nie ma na li¶cie, ustaw prze³±cznik audio/off w pozycji off, 
z powrotem w pozycji audio i/lub zrestartuj komputer.
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 Audio Manager – Rodzaje plików

lików d¼wiêkowych w programie Nokia Audio Manager
ieje kilka rodzajów plików d¼wiêkowych, które s± obs³ugiwane przez program Nokia Au
le¿y to od dostêpno¶ci programów uzupe³niaj±cych. Zwróæ uwagê, ¿e tylko pliki niektó
atów mog± byæ u¿ywane w odtwarzaczu Nokia Music Player.

* Do odczytu musi byæ zainstalowany Windows Media Player. 
† Do odczytu musi byæ zainstalowany Real Player. 
‡ Musi byæ zainstalowany InterRights Point.
§ Do odczytu musi byæ zainstalowany QuickTime. 

Pliki, które mog± byæ zainstalowane w odtwarzaczu Nokia Music Player.

Pliki Audio G.721
Lista utworów MS Media 
Lista utworów MS Media 
Microsoft Movie 
Pliki Universal Music Group 
Reference 
Pliki Universal Music Group Offer 
Pliki Universal Music Group 
Content 
Pliki CD Audio 
Nokia LSE DRM 
Pliki MPEG Audio 
Plik MS Movie 
Plik listy utworów 

.mov § Quicktime Movie 

.pls Lista utworów PLS 

.ra † Pliki RealAudio 

.ram † RealAudio Streams 

.saf ‡ Pliki DigiBox Audio 

.sm3 Pliki Secure Audio 

.smil Pliki RA SMIL 

.wav Pliki Wave Audio 

.wax * Lista utworów MS Medi

.wm * Lista utworów MS Medi

.wma Pliki Microsoft Window
Audio

.wmv * Lista utworów MS Medi

.wmx * Lista utworów MS Medi

.wvx * Lista utworów MS Medi
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 CD Manager – Komunikaty o b³êdach

ie: Dlaczego zosta³ wy¶wietlony komunikat o b³êdzie z przyciskiem Cancel?
ied¼:Komunikat taki pojawia siê, gdy klikniesz przycisk  na pasku tytu³owym progra

odczytywania p³yty CD. Aby chroniæ czytnik CD, u¿yj w zamian przycisku 
ie: Kiedy próbujê kopiowaæ, zmieniæ nazwê lub odczytaæ plik, pojawia siê komunikat

Could not copy file.
ied¼:Pliku nie mo¿na skopiowaæ, zmieniæ jego nazwy lub nie mo¿na go odczytaæ, poni

najpewniej jest ju¿ u¿ywany. Je¿eli masz inne urz±dzenie muzyczne otwarte w ko
zamknij je, zanim bêdziesz kontynuowaæ. 
Pliku nie da siê skopiowaæ, nie mo¿na zmieniæ mu nazwy lub nie mo¿na go odczy
wtedy, gdy nie jest to plik audio lub gdy jest zapisany w formacie niezgodnym z od
Nokia Music Player.

ie: Co oznacza komunikat Device not attached?
ied¼:Oznacza, ¿e program Nokia CD Manager nie mo¿e wykryæ urz±dzenia. Sprawd¼:

• Czy urz±dzenie jest pod³±czone do komputera? (Patrz punkt Pod³±czanie odtwarzacza 
komputera).

• Czy kabel USB jest mocno w³o¿ony zarówno do komputera jak i urz±dzenia?

ie: Co oznacza komunikat Free Space?
ied¼:Oznacza, ¿e za ma³o jest miejsca na karcie pamiêci Nokia Music Player, aby móc 

operacjê. Skorzystaj z opcji Delete Tracks w oknie Media on Device, aby usun±æ
pamiêci odtwarzacza.

ie: Co oznacza komunikat Load an audio CD?
ied¼:Oznacza, ¿e powiniene¶ w³o¿yæ p³ytê audio CD do napêdu CD-ROM i ponowiæ pró

Nokia CD Manager nie mo¿e wykryæ p³yty w napêdzie CD-ROM. Sprawd¼:
• Czy p³yta audio CD znajduje siê w napêdzie dysków?
• Czy napêd CD-ROM jest zamkniêty?
• Czy napêd CD-ROM jest u¿ywany?
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 Music Player – Komunikaty o b³êdach

ie: W odtwarzaczu Nokia Music Player pojawia siê komunikatUnsupported Audio.
ied¼:Próbujesz odczytaæ plik, którego format nie jest obs³ugiwany przez odtwarzacz N

Player, np. WMA. image lub inny.

ie: W odtwarzaczu Nokia Music Player pojawia siê komunikatUnusable Media.
ied¼:Karta pamiêci nie jest obs³ugiwana przez odtwarzacz Nokia Music Player. Wymi

oryginaln± kartê pamiêci lub inn±, obs³ugiwan± przez odtwarzacz. (Patrz punkt K
pamiêci).

ie: W odtwarzaczu Nokia Music Player pojawia siê komunikatUnknown Format.
ied¼:Na karcie pamiêci zosta³y zapisane informacje w nieobs³ugiwanym formacie. Mu

mo¿e byæ odtwarzana. Przeformatuj kartê pamiêci za pomoc± programu Nokia A
Manager, aby¶ móg³ korzystaæ z Nokia Music Player.

ie: W odtwarzaczu Nokia Music Player pojawia siê komunikatRead Error.
ied¼:Karta pamiêci mo¿e byæ uszkodzona lub zasilana z niestabilnego ¼ród³a. Wymieñ

nowe. Je¿eli komunikatRead Error pojawi siê ponownie, wymieñ kartê pamiêci n

ie: W odtwarzaczu Nokia Music Player pojawia siê komunikat Data Error.
ied¼:Wybrany utwór jest uszkodzony i nie mo¿na go odtwarzaæ. Naci¶nij  lub 

do innego utworu.

ie: W odtwarzaczu Nokia Music Player pojawia siê komunikatDRM Error.
ied¼:Pojawi³ siê problem z Digital Rights Management i nie mo¿na odtwarzaæ wybran

Naci¶nij  lub , aby przej¶æ do innego utworu.

ie: W odtwarzaczu Nokia Music Player pojawia siê komunikat No Media.
ied¼:Karta pamiêci nie zosta³a w³o¿ona lub w³o¿ono j± nieprawid³owo. W³ó¿ kartê pa

sprawd¼, czy jest prawid³owo zainstalowana. (Patrz punkt Wk³adanie karty pam
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tanie: W odtwarzaczu Nokia Music Player pojawia siê komunikat Format Error.
powied¼:Komunikat ten mo¿e siê pojawiæ podczas formatowania karty pamiêci programe

Audio Manager. Spróbuj sformatowaæ kartê pamiêci za pomoc± programu Nokia
Manager. Brak komunikatu Format Error oznacza, ¿e b³±d zosta³ usuniêty.

tanie: W odtwarzaczu Nokia Music Player pojawia siê komunikat No Track.
powied¼:Na karcie pamiêci nie zosta³y zapisane ¿adne utwory. Skopiuj utwory muzyczne,

z programu Nokia Audio Manager lub CD Manager. (Patrz punkt Przesy³anie plik
muzycznych do karty d¼wiêkowej (Nokia Audio Manager) lub Kopiowanie do o
ods³uchiwanie muzyki (Nokia CD Manager)).

tanie: W odtwarzaczu Nokia Music Player pojawia siê komunikat Connect Error.
powied¼:Odtwarzacz Nokia Music Player jest pod³±czony nieprawid³owo kablem USB do k

karta pamiêci zosta³a wyjêta w czasie, gdy odtwarzacz by³ pod³±czony do kompu
w³ó¿ ponownie kartê pamiêci. Przeczytaj rozdzia³ o wk³adaniu karty pamiêci. Wy
odtwarzacz, od³±cz go, i ponownie pod³±cz do komputera. (Patrz punkt Pod³±cza
odtwarzacza do komputera).
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 Music Player – Rozwi±zywanie problemów

m Prawdopodobna 
przyczyna

Rozwi±zanie

rzacz Nokia Music 
nie dzia³a.

Blokada jest w³±czona. Wy³±cz blokadê.

Karta pamiêci jest 
w³o¿ona nieprawid³owo.

Sprawd¼ kartê pamiê

Bateria jest roz³adowana. Wymieñ bateriê.

Jest pod³±czony do 
komputera.

Od³±cz odtwarzacz o
komputera.

 s³ychaæ. Poziom g³o¶no¶ci jest 
zbyt niski.

Ustaw poziom g³o¶no

Kabel s³uchawki jest 
w³o¿ony nieprawid³owo.

Sprawd¼ pod³±czenie

£±cze jest 
zanieczyszczone.

Wyczy¶æ ³±cze i w³ó¿
z powrotem.

æ zak³ócenia. Kabel Phone/PC owin±³ 
siê wokó³ odtwarzacza.

Odwiñ kabel 
z odtwarzacza.
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blem Prawdopodobna 
przyczyna

Rozwi±zanie

j rozmówca mnie nie 
zy.

Mikrofon jest zbyt daleko 
od ust.

Umie¶æ mikrofon 
w odleg³o¶ci nie wiêk
ni¿ 15 cm od ust.

Ha³as w otoczeniu jest 
zbyt du¿y.

Przejd¼ do cichszego
pomieszczenia.

awia siê komunikat 
n’t find a portable 
ice”.

Karta pamiêci jest 
w³o¿ona nieprawid³owo.

W³ó¿ prawid³owo kar
pamiêci.

Odtwarzacz Nokia Music 
Player nie jest w³±czony.

W³±cz odtwarzacz.

Kabel USB jest 
pod³±czony 
nieprawid³owo.

Sprawd¼ pod³±czenie

 mo¿na zamkn±æ 
rywy karty pamiêci.

Karta pamiêci jest 
w³o¿ona nieprawid³owo.

W³ó¿ prawid³owo kar
pamiêci.

Karta pamiêci jest 
niew³a¶ciwa.

Upewnij siê, czy kart
pamiêci ma ten sam 
rozmiar co oryginaln
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blem Prawdopodobna 
przyczyna

Rozwi±zanie

bieranie g³osowe nie 
a³a.

Telefon, gdy pod³±czony 
do Nokia Music Player, 
nie obs³uguje funkcji 
wybierania g³osowego.

Funkcjê wybierania 
g³osowego obs³uguj±
telefony Nokia 3310
8890.

Telefon Nokia nie ma ¼le 
ustawion± funkcjê 
wybierania g³osowego.

Zapoznaj siê z instru
obs³ugi telefonu.

Odtwarzacz Nokia Music 
Player jest nieprawid³owo 
pod³±czony do telefonu 
Nokia.

Sprawd¼ pod³±czenie
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oatacja i konserwacja

usic Player
cz Nokia Music Player nale¿y do szczytowych 
 nowoczesnej techniki i wymaga umiejêtnego 
ania siê nim. Przestrzeganie poni¿szych 
ek zapewni spe³nienie wszystkich warunków 
ji i pozwoli na bezawaryjn± pracê urz±dzenia 
le lat. Korzystaj±c z odtwarzacza Nokia Music 
stosuj siê do poni¿szych zaleceñ:

zenie i jego wszystkie elementy przechowuj 
jscu niedostêpnym dla ma³ych dzieci.
 urz±dzenie przed wilgoci±. Opady, du¿a 
no¶æ i ciecze zawieraj±ce zwi±zki mineralne 

 powodowaæ korozjê obwodów elektronicznych.
ywaj i nie przechowuj urz±dzenia w miejscach 
ych i zapylonych. Mo¿e to bowiem spowodowaæ 
dzenie jego ruchomych czê¶ci.
zechowuj urz±dzenia w wysokiej temperaturze. 
 ona ¿ywotno¶æ baterii i podzespo³ów 

onicznych, mo¿e spowodowaæ odkszta³cenia, a 
 stopienie elementów plastykowych.
zechowuj urz±dzenia w niskiej temperaturze. 
rz±dzenie podczas pracy ogrzewa siê (do 
lnej temperatury), w jego wnêtrzu gromadzi siê 
, co mo¿e spowodowaæ uszkodzenie 

spo³ów elektronicznych.
óbuj otwieraæ urz±dzenia. Niefachowa ingerencja 
spowodowaæ jego uszkodzenie.

• Nie rzucaj, nie upuszczaj i nie obijaj urz
Nieostro¿ne obchodzenie siê z urz±dzen
spowodowaæ uszkodzenia podzespo³ów
elektronicznych.

• Do czyszczenia urz±dzenia nie stosuj ¿r
chemikaliów, rozpuszczalników lub siln
detergentów. Przecieraj urz±dzenie miê
zwil¿on± roztworem ³agodnego myd³a.

• Nie maluj i nie lakieruj urz±dzenia. Farb
mog± skleiæ ruchome czê¶ci i uniemo¿li
dzia³anie.

• U¿ywaj tylko dostarczonych wraz z urz±
akcesoriów. Niefachowe modyfikacje lu
nieodpowiednie akcesoria mog± spowo
uszkodzenia odtwarzacza lub obni¿enie
parametrów.

• Je¶li stwierdzisz jakiekolwiek usterki w 
odtwarzacza, jego czê¶ci lub akcesoriów
urz±dzenie do najbli¿szego autoryzowa
Uzyskasz tam pomoc w rozwi±zaniu pro
w ewentualnej naprawie.

Karta pamiêci
• Gdy kupisz now± kartê MMC (Multimed

przyklej towarzysz±c± jej etykietê we w
miejscu karty. Nic innego do karty nie p
chcesz co¶ napisaæ na etykiecie, zrób to
przykleisz do karty. Je¶li co¶ chcesz nap
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zyklejonej ju¿ etykiecie, u¿yj miêkkiego pisaka. Nie 
ywaj ani pióra, ani d³ugopisu. 

 odtwarzaczu Nokia Music Player u¿ywaj tylko kart 
MC (Multimedia Card). 
¶li chcesz nabyæ now± lub dodatkow± kartê pamiêci, 
p kartê o tych samych rozmiarach co oryginalna. 
e¼ ze sob± oryginalna kartê pamiêci do sklepu, 
którym kupujesz now± kartê, aby upewniæ siê, ¿e 
wa karta jest tych samych rozmiarów. Wszystkie 
rty tych samych rozmiarów nadaj± siê do 
twarzacza Nokia Music Player.
szystkie karty pamiêci przechowuj w miejscu 
edostêpnym dla ma³ych dzieci.
rty pamiêci i ich zawarto¶æ mo¿na ³atwo uszkodziæ 
zez porysowanie lub wygiêcie. Nale¿y zachowaæ 
tro¿no¶æ podczas instalowania i wyjmowania karty.
nim zainstalujesz kartê pamiêci, zawsze sprawdzaj, 
y odtwarzacz Nokia Music Player jest wy³±czony.
e u¿ywaj i nie przechowuj karty pamiêci w wysokich 
mperaturach, nie wystawiaj jej na dzia³anie promieni 
necznych i unikaj du¿ej wilgotno¶ci powietrza. Nie 
pu¶æ do kondensacji pary wodnej na karcie.
zymaj kartê z daleka od materia³ów powoduj±cych 
rozjê.

• Unikaj dotykania styków elektrycznych.
• Nie wk³adaj karty pamiêci do innych ur

jak np. kamera cyfrowa, poniewa¿ mo¿e
spowodowaæ uszkodzenie karty lub utra
na niej informacji.

Bateria
• Odtwarzacz Nokia Music Player zasilan

AAA. Nie próbuj u¿ywaæ baterii innego 
• Wy³±cz odtwarzacz Nokia Music Player

otwarciem komory i wymian± baterii.
• Do zasilania Nokia Music Player mo¿na

akumulatorków. Przed do³adowaniem sp
to akumulatorek, a nie bateria, i czy u¿y
odpowiedniej ³adowarki.

• Pozostawienie baterii w gor±cych lub zi
miejscach, takich jak zamkniêty samoch
zim±, spowoduje zmniejszenie jej pojem
¿ywotno¶ci. Staraj siê zawsze przechow
w temperaturze od 15°C do 25 °C (od 5
Je¿eli bêdziesz korzysta³ z przegrzanej l
wych³odzonej baterii, odtwarzacz Nokia
mo¿e chwilowo nie dzia³aæ, nawet je¶li 
w pe³ni na³adowana.

• Zu¿yte baterie nale¿y obowi±zkowo prz
recyklingu lub pozbyæ siê ich zgodnie z 
przepisami. Nigdy nie wyrzucaj baterii d
na ¶mieci!

nalepka
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 techniczne

ter

waga: *Karta d¼wiêkowa nie jest wymagana, ale bez niej nie mo¿na odtwarzaæ na komputerze muzyki z program
Audio Manager.
†Prêdko¶æ napêdu CD-ROM mo¿e mieæ wp³yw na jako¶æ dekodowania.

ent Wymagania
puter Zgodny z IBM PC/AT.
esor Pentium MMX 266 MHz (wymagany). Pentium 300 MHz (zalecany)
iêæ Minimum 48 MB (zalecane). Dla systemu Windows 2000 zalecane 6
 twardy Do instalacji oprogramowania potrzeba 35 MB wolnego miejsca. Dl

muzycznych potrzebne jest dodatkowe wolne miejsce.
em operacyjny Windows 98/Windows ME/Windows 2000. To oprogramowanie nie 

u¿ywane w systemie Windows 95/3.1 ani Windows NT. Ponadto opr
nie jest obs³ugiwane na komputerach w³asnej konstrukcji (sk³adaka
z zainstalowanym systemem Windows 98 i (lub) na komputerach, w
operacyjny zosta³ uaktualniony z Windows 95/3.1 na Windows 98.

wietlacz/Monitor Rozdzielczo¶æ wiêksza ni¿ 800 x 600 pikseli. Liczba kolorów wiêksz
(ustawienie High Color).

gl±darka Microsoft Internet Explorer lub Netscape Navigator, wersja 4.0 lub 
ugiwane formaty importowanych 
w

ACC, MP3, WAV, CD-DA (p³yty CD z muzyk±)

 USB Wersja 1.0/1.1 lub nowsza.
êd CD-ROM† Standard SCSI/ANSI X3T10-1048D. Standard ATAPI/SFF-8020i.
cana karta d¼wiêkowa* Sound Blaster 16 (zalecana)
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ta pamiêci

Zakup nowej karty

Do wspó³pracy z odtwarzaczem nadaj± siê wszystkie karty typu Multimedia Cards (MMC).
kupiæ now± lub dodatkow± kartê pamiêci, sprawd¼ czy ma te same rozmiary co oryginalna
karty i standardy s± stale udoskonalane, niektóre z wyprodukowanych w przysz³o¶ci kart m
dzia³aæ prawid³owo z odtwarzaczem. 

Wybór rozmiaru karty pamiêci

Obs³ugiwane s± karty o pojemno¶ciach 32 MB i 64 MB.

cane szybko¶ci bitowe kodowania
Odtwarzacz Nokia Music Player zosta³ zaprojektowany tak, aby móg³ przechowaæ 64 minu
karcie 32 MB przy kodowaniu AAC.

Aby ustawiæ szybko¶æ bitow± kodowania u¿ywan± przez odtwarzacz Nokia Music Player, p
Options > Read CD > Bit Rate w programie Nokia Audio Manager.

* Uwaga: Najlepsza = jako¶æ profesjonalna

Lepsza = jako¶æ CD

Dobra = jako¶æ zbli¿ona do CD

Jako¶æ d¼wiêku Pojemno¶æ karty 32 MB 
(minuty)

Ws
kkBit/s MP3 AAC

128 Dobra *Njalepsza 32 1
96 OK *Lepsza 48
64 S³aba *Dobra 64
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alnianie – program Nokia Audio Manager

udio Manager V1.0 i Nokia CD Manager to standardowe programy sprzedawane r
rzaczem Nokia Music Player.

ytkownik odwiedza czêsto witrynê club.nokia.com i wprowadzi³ numer seryjny od
s rejestracji w tej witrynie, bêdzie móg³ uaktualniaæ i dodawaæ nowe funkcje do o

usic Player oraz do programów Nokia Audio Manager i Nokia CD Manager. Bêdz
 pobieraæ inne pliki.

http://www.club.nokia.com/
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alnianie – odtwarzacz Nokia Music Player

czne narzêdzie do uaktualniania oprogramowania
zacz Nokia Music Player zosta³ zaprojektowany tak, aby mo¿na by³o ³atwo uaktua
mowanie urz±dzenia. Uaktualnianie oprogramowania zapewnia:
wiêkszanie wydajno¶ci dzia³ania oprogramowania,
ostêp do funkcji, które mog³y zostaæ dodane do urz±dzenia ju¿ po jego zakupie.

waga: Do pobierania uaktualnieñ oprogramowania potrzebne jest aktywne po³±cz
z sieci± Internet.

alizacja oprogramowania

iej±ce oprogramowanie wewnêtrzne jest przechowywane w katalogu: 
y Computer\Nokia\Utilities\nmpv1sw.exe 

pv1sw.exe jest plikiem oprogramowania wewnêtrznego. Wszystkie nowe, pobrane z In
gramy wewnêtrzne musz± byæ umieszczone w tym samym katalogu Utilities.

tualnianie oprogramowania wewnêtrznego
y³±cz odtwarzacz Nokia Music Player, ustawiaj±c prze³±cznik audio/off w pozycji off

od³±cz odtwarzacz Nokia Music Player do komputera. (Patrz punkt Pod³±czanie odtwa
omputera). 
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• Naci¶nij jednocze¶nie  i , i ustaw prze³±cznik audio/off w pozycji audio.

• Komunikat Firmware upgrade przewija siê na wy¶wietlaczu odtwarzacza Nokia Music 

• Kliknij dwukrotnie plik nmpv1sw.exe.
• Odczekaj kilka sekund, a¿ komputer wy¶wietli komunikat Programming the FLASH.
• Komunikat Update przewija siê na wy¶wietlaczu Nokia Music Player.

• Firmware upgrade Odczekaj kilka sekund, a¿ komputer wy¶wietli komunikat Firmware
upgraded successfully!.

• Na wy¶wietlaczu pojawi± siê napisy Nokia i MusicOn.
• Uaktualnienie oprogramowania wewnêtrznego zosta³o zakoñczone.

Naci¶nij oba 
jednocze¶nie

Firmwareupgrade

Update
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icje

C (Advanced Audio Coding) jest formatem kodowania opracowanym przez firmy Dolb
haufer, AT&T i Sony Format AAC jest nastêpn± generacj± po formacie MP3. Pliki w tym
uj± mniej miejsca na twardym dysku i karcie pamiêci.

æ bitowa: Szybko¶æ bitowa oznacza czêstotliwo¶æ próbkowania pomno¿on± przez liczb
róbkê". Podczas próbkowania muzyki amplituda drgañ, czyli poziom d¼wiêku zmienia s
zo cichego do bardzo g³o¶nego. Ten zakres musi zostaæ wyra¿ony przez okre¶lon± liczb
n bit oznacza "w³±czony lub wy³±czony", czyli niezbyt wysok± jako¶æ. Osiem bitów daj
omów, co wystarcza dla zupe³nie dobrej s³yszalno¶ci rozmowy. Natomiast 24 bity daj±
nów poziomów, a to jest ju¿ wiêcej ni¿ cz³owiek jest zdolny rozró¿niæ. Bierzemy wiêc 

totliwo¶æ próbkowania, mno¿ymy j± przez wybran± liczbê bitów na próbkê i przesy³am
wodem. To daje nam "szybko¶æ bitow±". Ogólnie, im wiêksza szybko¶æ bitowa tym leps
iêku.

CD: Pliki o jako¶ci CD zapewniaj± wysok± jako¶æ d¼wiêku. Pliki o jako¶ci CD s± najmnie
presowanymi plikami muzyki cyfrowej i zajmuj± du¿o miejsca na dysku twardym. Je¶li

rany format AAC lub MP3 w menu View > Options > Read CD, do wyboru bêdzie piêæ 
¶ci od 112kBit/s przy wspó³czynniku kompresji 11.25 : 1 do 320kBit/s przy wspó³czynn
presji 4.4 : 1. 1 to 320kBit/s at 4.4 : 1. 

anie cyfrowymi prawami autorskimi:Zarz±dzanie cyfrowymi prawami autorskimi (Di
ts Management, DRM) jest systemem zabezpieczania przed kopiowaniem, zarz±dzania
owszechnianiem tre¶ci, zarz±dzania sprzeda¿± i pobieraniem op³at za odtwarzanie, któ
a autorskie twórców i producentów.

ogniowa:System ograniczaj±cy przep³yw danych miêdzy sieci± lokaln± a Internetem, w
 zapewnienia bezpieczeñstwa. Zapora ogniowa limituje dostêp i pewne formy komun

zy komputerami w sieci lokalnej i tymi w Internecie.
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gramowanie wewnêtrzne: Oprogramowanie umo¿liwiaj±ce dzia³anie odtwarzacza Nokia
layer. G³ówne oprogramowanie wewnêtrzne systemu.

¶æ radiowa FM:Jako¶æ radiowa FM oznacza najni¿sz± jako¶æ d¼wiêku. Pliki w tym formaci
ajmniejsz± ilo¶æ miejsca. Po wybraniu formatu AAC lub MP3 menu View > Options > Re
¼wiêk bêdzie rejestrowany z szybko¶ci± 64 kBit/s przy kompresji 22,5 : 1. 1 compression.

nek muzyczny: Gatunek muzyczny jest to styl lub rodzaj utworu muzycznego.

Internet Service Provider (Dostawca us³ug internetowych). Firma, która ³±czy u¿ytkowników
ternet. 

: MP3 to skrót od MPEG (Motion Picture Experts Group) Layer 3. MP3 jest formatem plikó
uzycznych, które maj± stosunkowo niewielki rozmiar, ale zapewniaj± wysok± jako¶æ d¼wi
P3 to skompresowane pliki audio, które zajmuj± ma³o miejsca na dysku twardym. Na prz

twór w formacie MP3 o rozmiarze 3062 KB, w formacie wav. zajmowa³by 33746 KB pam

¶æ zbli¿ona do CD: Gdy na dysku jest ma³o miejsca, jako¶æ zbli¿ona do CD jest dobrym 
ozwi±zaniem. Jako¶æ d¼wiêku jest podobna do jako¶ci CD, ale pliki s± mniejsze. Po wybran
ormatu AAC lub MP3 menu View > Options > Read CD do wyboru bêd± dwa typy jako¶ci
o CD. S± to 96kBit/s przy kompresji 15 : 1 lub 80kBit/s z kompresj± 18 : 1.

totliwo¶æ próbkowania: Czêstotliwo¶æ próbkowania okre¶la szybko¶æ pobierania próbek z
mieniaj±cego siê sygna³u muzycznego. 

ualnienie: Pobieranie najnowszych wersji oprogramowania wewnêtrznego lub programó

A: WMA jest skrótem od Windows Media Audio (format plików d¼wiêkowych w systemie
indows). 


